User’s Guide

B411d (N22200B)
B411dn (N22201B)
B431d (N22202B)
B431dn (N22203B)
PREFACE

Every effort has been made to ensure that the information in this document is complete, accurate, and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its control. The manufacturer also cannot guarantee that changes in software and equipment made by other manufacturers and referred to in this guide will not affect the applicability of the information in it. Mention of software products manufactured by other companies does not necessarily constitute endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness of the information contained herein.

The most up-to-date drivers and manuals are available from:

www.okiprintingsolutions.com

Copyright © 2010 Oki Oki Data Corporation All rights reserved.

Oki is a registered trademark of Oki Electric Industry Company, Ltd.

Oki Printing Solutions is a trademark of Oki Data Corporation.

Hewlett-Packard, HP, and LaserJet are registered trademarks of Hewlett-Packard Company.

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corporation.

ENERGY STAR is a trademark of the United States Environmental Protection Agency.

Apple, Macintosh, Mac and Mac OS are registered trademarks of Apple Computer.

Other product names and brand names are registered trademarks or trademarks of their proprietors.

As an ENERGY STAR Program Participant, the manufacturer has determined that this product meets the ENERGY STAR guidelines for energy efficiency.

This product complies with the requirements of the Council Directives 2004/108/EC (EMC), 2006/95/EC (LVD), 1999/5/EC (R&TTE) and 2009/125/EC (EuP), as amended where applicable, on the approximation of the laws of the member states relating to Electromagnetic Compatibility, Low Voltage, Radio & Telecommunications Terminal Equipment and Energy Using Products.

The following cables were used to evaluate this product to achieve EMC directive 2004/108/EC compliance and configurations other than this may affect that compliance.

<table>
<thead>
<tr>
<th>CABLE TYPE</th>
<th>LENGTH (METRE)</th>
<th>CORE</th>
<th>SHIELD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>1.8</td>
<td>×</td>
<td>×</td>
</tr>
<tr>
<td>USB</td>
<td>5</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>Parallel</td>
<td>1.8</td>
<td>×</td>
<td>✓</td>
</tr>
<tr>
<td>LAN</td>
<td>15</td>
<td>×</td>
<td>×</td>
</tr>
</tbody>
</table>

Preface > 2
EMERGENCY FIRST AID

Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, flush with large amounts of water for at least 15 minutes keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of staining skin or clothing.

MANUFACTURER

Oki Data Corporation,
4-11-22 Shibaura, Minato-ku,
Tokyo 108-8551,
Japan

ENVIRONMENTAL INFORMATION
CONTENTS

Preface ................................................. 2
Emergency First Aid ...................................... 3
Manufacturer ........................................... 3
Importer to the EU/authorised representative ........... 3
Environmental information ............................. 3
Contents ................................................ 4
Notes, Cautions and Warnings ......................... .6
Introduction ............................................. 7
Printer features ......................................... 7
Using your printer ....................................... 7
About this manual .................................... 8
Online usage ........................................... 8
Printing Pages ......................................... 8
Abbreviations used .................................... 9
Printer components .................................... 10
Operator panels ......................................... 12
B411d, B411dn ........................................... 12
Operator panel ......................................... 12
LED indicators ......................................... 12
LCD .................................................... 13
Online button .......................................... 13
Changing language ..................................... 14
Configuration tool ..................................... 14
Menu functions ........................................ 15
Printing menu settings ................................ 21
B431d, B431dn ........................................... 22
Operator panel ......................................... 22
Panel elements ......................................... 22
Menu functions ........................................ 24
Printing menu settings ................................ 29
Paper recommendations ............................... 30
Paper and envelope types ............................. 30
Transparencies and adhesive labels .................. 30
Postcards .............................................. 31
Installing paper ........................................ 31
Paper Tray ............................................. 31
Multi purpose tray and manual feed tray .......... 33
Paper feed, size and media setting ................. 34
B411d, B411dn ........................................... 34
B431d, B431dn ........................................... 35
Interfaces ................................................ 37
Printer drivers .......................................... 38
Windows operating systems ......................... 38
Installed options ....................................... 38
Macintosh operating systems ....................... 38
Installed options ....................................... 38
Choosing a Mac driver ............................... 38
NOTES, CAUTIONS AND WARNINGS

NOTE
A note provides additional information to supplement the main text.

CAUTION!
A caution provides additional information which, if ignored, may result in equipment malfunction or damage.

WARNING!
A warning provides additional information which, if ignored, may result in a risk of personal injury.

For the protection of your product, and in order to ensure that you benefit from its full functionality, this model has been designed to operate only with genuine original toner cartridges. Any other toner cartridge may not operate at all, even if it is described as “compatible”, and if it does work, your product's performance and print quality may be degraded.

Specifications subject to change without notice. All trademarks acknowledged.
INTRODUCTION

Congratulations on purchasing this monochrome page printer. Your new printer is designed with a range of advanced features to give you crisp black and white pages at high speed on a wide range of print media.

For your information, a summary of the main features of your printer is given below.

PRINTER FEATURES

> Four different models to choose from: B411d, B411dn, B431d, B431dn (d denotes Duplex included and n denotes Network Interface Card included).
> Memory: 64MB.
> Resolution: 1200 x 600 dpi for B411d, B411dn; 1200 x 1200 dpi for B431d, B431dn.
> Paper handling: 250 sheets (80g/m²).
> Emulation: standard Printer Control Language PCL5e, PCLXL, Epson FX, IBM ProPrinter and PostScript3 for B431d, B431dn.
> Barcodes: embedded for SIDM emulations.
> Flash DIMM: 1.28MB for B411d, B411dn and 4.6MB for B431d, B431dn to allow the storage of additional fonts or bar codes.
> USB 2.0 High speed and Parallel interfaces.
> 10/100 BASE-TX Network: standard for B411dn, B431dn, lets you share this valuable resource among users on your office network.
> Multi Purpose tray for B431d, B431dn: to extend the range of media your printer can accommodate (capacity 100 sheets (80g/m²) or 10 envelopes), and can also use as manual duplex.
> Manual Feed tray for B411d, B411dn: to feed single sheets, heavy paper stocks, envelopes, other special media and can also use as manual duplex for B411d, B411dn.
> Auto Duplex: standard feature in all models.
> “Ask Oki” – a user-friendly function that gives a direct link from your printer driver screen (but not illustrated in this guide) to a dedicated web site specific to the exact model you are using. This is where you’ll find all the advice, assistance and support you could need to help you get the best possible results from your Oki printer.

Additionally, the following optional features are also available:

> 64, 128, 256MB RAM DIMM: to extend the main memory of your printer and speed up the processing of large files.
> Second paper tray: to increase your printer’s paper handling capacity by 530 sheets (80g/m²).

USING YOUR PRINTER

To help you get the most from your printer, the manufacturer has provided a variety of supporting materials. A summary of these materials and their purposes is given in the following chapter.
ABOUT THIS MANUAL

This manual is the user’s guide (check the Oki Printing Solutions website, www.okiprintingsolutions.com, for the most up-to-date version) for your printer and forms part of the overall user support listed below:

> **Quick Set-up Guide**: to describe how to unpack, connect and power up your printer.

> **Installation Safety booklet**: provides information for safe use of your product. This is a paper document that is packaged with the product.

> **This User’s Guide**: to help you to operate your printer and make the best use of its many features. Also included are guidelines for troubleshooting and maintenance to ensure that it performs at its best. Additionally, information is provided for adding optional accessories as your printing needs evolve.

> **Network Guide**: helps you become familiar with the functionality of the built in network interface card.

> **Installation Guides**: accompany consumable items and optional accessories to describe how to install them.

> **Online Help**: online information associated with the printer driver and Status Monitor software.

This manual has been written using more than one printer as a model and the illustrations/screenshots reflect this. What you see will be appropriate to the model you are using.

ONLINE USAGE

This manual is intended to be read on screen using an Adobe Acrobat Reader. Use the navigation and viewing tools provided in Acrobat.

You can access specific information in two ways:

> In the list of bookmarks down the left hand side of your screen, click on the topic of interest to jump to the required topic. (If the bookmarks are not available, use the Table of Contents.)

> In the list of bookmarks click on Index to jump to the Index. (If the bookmarks are not available, use the Table of Contents.) Find the term of interest in the alphabetically arranged index and click on the associated page number to jump to the page containing the subject.

PRINTING PAGES

The whole manual, Individual pages, or sections may be printed. The procedure is:

1. From the toolbar, select **File > Print** (or press the Ctrl + P keys).
2. Choose which pages you wish to print:
   (a) All pages, for the entire manual.
   (b) Current page for the page at which you are looking.
   (c) Pages from and to for the range of pages you specify by entering their page numbers.

3. Click OK.

**ABBREVIATIONS USED**

The following abbreviations are used in this manual:

<table>
<thead>
<tr>
<th>ABBREVIATION</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl</td>
<td>Control</td>
</tr>
<tr>
<td>dpi</td>
<td>dots per inch</td>
</tr>
<tr>
<td>DIMM</td>
<td>Dual In-line Memory Module</td>
</tr>
<tr>
<td>d</td>
<td>duplex</td>
</tr>
<tr>
<td>n</td>
<td>network card installed</td>
</tr>
<tr>
<td>LED</td>
<td>Light Emitting Diode</td>
</tr>
<tr>
<td>NIC</td>
<td>Network Interface Card</td>
</tr>
<tr>
<td>PCL</td>
<td>Printer Control Language</td>
</tr>
<tr>
<td>PS</td>
<td>PostScript (emulation)</td>
</tr>
<tr>
<td>PSE</td>
<td>PostScript Emulation</td>
</tr>
<tr>
<td>RAM</td>
<td>Random Access Memory</td>
</tr>
</tbody>
</table>
PRINTER COMPONENTS

Apart from the Operator panels, which are described in the next chapter, the B411d, B411dn, B431d, B431dn printers look similar from the outside. The important components are identified in the representations below. For illustration purposes the B431dn model is shown.

1. Operator panel
2. Output Stacker (150 sheets, face down)
3. Output Stacker extension
4. Top cover release button
5. Multi Purpose Tray (only for B431d, B431dn; 100 sheets)(shown in open position)
6. Multi Purpose Tray extension
7. Paper Tray 250 sheets
8. ON/OFF switch
9. LED array
10. Fuser unit
11. Toner cartridge
12. Image drum
13. Top cover
14. Cooling fan
15. Memory panel (to upgrade your printer’s memory RAM DIMM)
16. Power cable connection
17. Parallel interface connection
18. LAN interface connection (only for B411dn, B431dn)
19. USB interface connection
20. Paper Tray extension
21. Rear Face Up Tray extension
22. Rear Face Up Tray
OPERATOR PANELS

This chapter describes the function of the operator panel on your printer. It is useful to describe the Configuration Tool at this point as it provides the B411d, B411dn, the equivalent of the menu control panel on the B431d, B431dn (See “Printer drivers” on page 38 for installation of the Configuration Tool.)

B411D, B411DN

OPERATOR PANEL

The B411d, B411dn operator panel consists of 2 indicating LEDs, an LCD (3) and an Online (4) button. The LEDs indicate Ready (1) and Attention (2).

LED INDICATORS

The LED indicators show the status of the printer and have three operating conditions as follows:

> Indicator off
> Indicator on
> Flash

Both LED indicators come on momentarily when power is switched on using the main power switch.

Ready LED (green)

> Indicator on - the printer is on-line and ready to receive data.
> Indicator off - the printer is off-line and cannot receive data.

Attention LED (red)

> Indicator on - this indicates a warning, (e.g. low toner).
> Indicator off - this indicates normal condition.

The meaning of the indicator LEDs when they flash (x) is summarised as follows:

---

NOTE
The table below is also applicable for the B431d, B431dn models.
The LCD (3) has two rows of up to 16 alphanumeric digits, displaying print status and error messages.

**ONLINE BUTTON**

The primary functions of the **Online** button (4) are activated by pressing the switch momentarily and releasing. The primary functions are as follows:

> Turning the printer off-line.
> Turning the printer on-line (ready).
> Resuming printing after page overflow.
> Interrupting data processing when the printer is receiving and processing data.
> Resuming data processing.

The secondary functions of the **Online** button are activated after turning the printer off line, then pressing and holding the switch for four seconds before releasing. The secondary functions are as follows:

> Printing the demo and menu pages.

> Printing any data held in the buffer after printing has been cancelled.
> Resetting the printer and clearing the buffer after printing has been cancelled.

<table>
<thead>
<tr>
<th>FLASH TYPE</th>
<th>READY LED (1)</th>
<th>ATTENTION LED (2)</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flash</td>
<td>x</td>
<td></td>
<td>The printer is receiving and processing data during printing or the printer is resetting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>x</td>
<td>There is a printing error, for example, a problem with paper, the cover is open or the paper tray is empty while a job is processing.</td>
</tr>
<tr>
<td></td>
<td>x</td>
<td>x</td>
<td>There is a minor error with the printer, for example, toner is low and the image drum needs to be changed.</td>
</tr>
</tbody>
</table>

**NOTE**

Demo and menu pages can also be printed using the printer’s Configuration Tool. See “Printing menu settings” on page 21.

**NOTE**

To reset the printer to the default settings of the manufacturer, the **Online** button is pressed and held down while the printer is switched on with the main power switch. The LED indicators blink when the printer has reset to the default settings.
**CHANGING LANGUAGE**

The default language used by your printer for display messages and for report printing is English. If required, this can be changed to:

- German
- Danish
- French
- Dutch
- Italian
- Turkish
- Spanish
- Portuguese
- Swedish
- Polish
- Russian
- Greek
- Finnish
- Czech
- Hungarian
- Norwegian

---

**NOTE**

1. The Operator Panel Language Setup Wizard will run automatically when you install the printer driver. Follow the instructions provided by this utility to set your chosen language.

2. The list above is neither conclusive nor exhaustive.

---

**CONFIGURATION TOOL**

Installation of the Configuration tool can be found on the Drivers/Utilities CD under the Utilities folder. Follow the on-screen instructions to complete the Configuration tool installation. This Configuration Tool is used to control and change the various printer settings.

**Using the Configuration Tool**

Viewing or changing the printer settings are carried out as follows:

Click on **Start > All Programs > Okidata > Configuration Tool** and select the **Configuration Tool**.
**MENU FUNCTIONS**

The Configuration tool allows you to view and change the printer’s internal settings. You can think of this as the software equivalent of the LCD operator panel.

In the Configuration tool, click the **Device Setting** tab. The settings are grouped into categories or “User Menu” such as **Information Menu** or **Print Menu**.

Some of these settings are similar to those found in your printer driver or application software. The settings that you can change using this software act as the printer’s defaults. These can be overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the **Print Menu** settings to one, this will be overridden if you select three copies of your document in the printer driver.

---

### Information menu

This menu provides a quick method of listing various items stored within the printer.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>ACTION</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT MENU MAP</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>NETWORK</td>
<td>EXECUTE</td>
<td>B411dn only</td>
</tr>
<tr>
<td>DEMO1</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT FILE LIST</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT PCL FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT PPR FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT FX FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT ERROR LOG</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>USAGE REPORT</td>
<td>EXECUTE</td>
<td></td>
</tr>
</tbody>
</table>
Print menu
This menu provides adjustment of various print job related functions.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>COPIES</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>DUPLEX</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>MANUAL</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>PAPER FEED</td>
<td>TRAY1</td>
<td></td>
</tr>
<tr>
<td>AUTO TRAY SWITCH</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>TRAY SEQUENCE</td>
<td>DOWN</td>
<td></td>
</tr>
<tr>
<td>MEDIA CHECK</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>RESOLUTION</td>
<td>600DPI</td>
<td></td>
</tr>
<tr>
<td>TONER SAVE MODE</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>ORIENTATION</td>
<td>PORTRAIT</td>
<td></td>
</tr>
<tr>
<td>LINES PER PAGE</td>
<td>64 LINES</td>
<td></td>
</tr>
<tr>
<td>EDIT SIZE</td>
<td>CASSETTE SIZE</td>
<td></td>
</tr>
</tbody>
</table>

Media menu
This menu provides adjustment to suit a wide range of print media.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRAY1 PAPERSIZE</td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td>TRAY1 MEDIATYPE</td>
<td>PLAIN</td>
<td></td>
</tr>
<tr>
<td>TRAY1 MEDIAWEIGHT</td>
<td>MEDIUM</td>
<td></td>
</tr>
<tr>
<td>TRAY2 PAPERSIZE</td>
<td>A4</td>
<td>When Tray2 is installed</td>
</tr>
<tr>
<td>TRAY2 MEDIATYPE</td>
<td>PLAIN</td>
<td>When Tray2 is installed</td>
</tr>
<tr>
<td>TRAY2 MEDIAWEIGHT</td>
<td>MEDIUM</td>
<td>When Tray2 is installed</td>
</tr>
<tr>
<td>MN PAPERSIZE</td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td>MN MEDIATYPE</td>
<td>PLAIN</td>
<td></td>
</tr>
<tr>
<td>MN MEDIAWEIGHT</td>
<td>MEDIUM</td>
<td></td>
</tr>
<tr>
<td>UNIT OF MEASURE</td>
<td>MILLIMETER</td>
<td></td>
</tr>
<tr>
<td>X DIMENSION</td>
<td>210 MILLIMETER</td>
<td></td>
</tr>
<tr>
<td>Y DIMENSION</td>
<td>297 MILLIMETER</td>
<td></td>
</tr>
</tbody>
</table>
System configuration menu

This menu adjusts general printer settings to suit the way you prefer to work.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>POW SAVE TIME</td>
<td>1 MIN</td>
<td></td>
</tr>
<tr>
<td>PERSONALITY</td>
<td>AUTO EMULATION</td>
<td></td>
</tr>
<tr>
<td>CLRABLE WARNING</td>
<td>ONLINE</td>
<td></td>
</tr>
<tr>
<td>AUTO CONTINUE</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>MANUAL TIMEOUT</td>
<td>60 SEC</td>
<td></td>
</tr>
<tr>
<td>TIMEOUT INJOB</td>
<td>40 SEC</td>
<td></td>
</tr>
<tr>
<td>TIMEOUT LOCAL</td>
<td>40 SEC</td>
<td></td>
</tr>
<tr>
<td>TIMEOUT NET</td>
<td>90 SEC</td>
<td>B411dn only</td>
</tr>
<tr>
<td>LOW TONER</td>
<td>CONTINUE</td>
<td></td>
</tr>
<tr>
<td>JAM RECOVERY</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>ERROR REPORT</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>HIGH HUM. MODE</td>
<td>OFF</td>
<td>If moistened paper (<em>) is curled significantly after printing, change the setting to ON. (</em> ) Moistened paper means paper that has been left in a high-humidity environment.</td>
</tr>
</tbody>
</table>

PCL Emulation

This menu controls the printer’s PCL emulation.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>FONT SOURCE</td>
<td>RESIDENT</td>
<td></td>
</tr>
<tr>
<td>FONT NO.</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>FONT PITCH</td>
<td>10.00 CPI</td>
<td></td>
</tr>
<tr>
<td>SYMBOL SET</td>
<td>PC-8</td>
<td></td>
</tr>
<tr>
<td>A4 PRINT WIDTH</td>
<td>78 COLUMN</td>
<td></td>
</tr>
<tr>
<td>WHITE PAGE SKIP</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>CR FUNCTION</td>
<td>CR</td>
<td></td>
</tr>
<tr>
<td>LF FUNCTION</td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td>PRINT MARGIN</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>PEN WIDTH ADJUST</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>TRAY ID#</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PCL MNID</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>PCL T0ID</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>PCL T1ID</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PCL T2ID</td>
<td>5</td>
<td>When Tray 2 is installed</td>
</tr>
</tbody>
</table>
PPR Emulation
This menu controls the printer’s PPR emulation.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER PITCH</td>
<td>10 CPI</td>
<td></td>
</tr>
<tr>
<td>FONT CONDENSE</td>
<td>12CPI TO 20CPI</td>
<td></td>
</tr>
<tr>
<td>CHARACTER SET</td>
<td>SET-2</td>
<td></td>
</tr>
<tr>
<td>SYMBOL SET</td>
<td>IBM-437</td>
<td></td>
</tr>
<tr>
<td>LETTER O STYLE</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>ZERO CHARACTER</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>LINE PITCH</td>
<td>6 LPI</td>
<td></td>
</tr>
<tr>
<td>WHITE PAGE SKIP</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>CR FUNCTION</td>
<td>CR</td>
<td></td>
</tr>
<tr>
<td>LF FUNCTION</td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td>LINE LENGTH</td>
<td>80 COLUMN</td>
<td></td>
</tr>
<tr>
<td>FORM LENGTH</td>
<td>11.7 INCH</td>
<td></td>
</tr>
<tr>
<td>TOF POSITION</td>
<td>0.0 INCH</td>
<td></td>
</tr>
<tr>
<td>LEFT MARGIN</td>
<td>0.0 INCH</td>
<td></td>
</tr>
<tr>
<td>FIT TO LETTER</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>TEXT HEIGHT</td>
<td>SAME</td>
<td></td>
</tr>
</tbody>
</table>

FX Emulation
This menu controls the printer’s FX emulation.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER PITCH</td>
<td>10 CPI</td>
<td></td>
</tr>
<tr>
<td>CHARACTER SET</td>
<td>SET-2</td>
<td></td>
</tr>
<tr>
<td>SYMBOL SET</td>
<td>IBM-437</td>
<td></td>
</tr>
<tr>
<td>LETTER O STYLE</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>ZERO CHARACTER</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>LINE PITCH</td>
<td>6 LPI</td>
<td></td>
</tr>
<tr>
<td>WHITE PAGE SKIP</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>CR FUNCTION</td>
<td>CR</td>
<td></td>
</tr>
<tr>
<td>LF FUNCTION</td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td>LINE LENGTH</td>
<td>80 COLUMN</td>
<td></td>
</tr>
<tr>
<td>FORM LENGTH</td>
<td>11.7 INCH</td>
<td></td>
</tr>
<tr>
<td>TOF POSITION</td>
<td>0.0 INCH</td>
<td></td>
</tr>
<tr>
<td>LEFT MARGIN</td>
<td>0.0 INCH</td>
<td></td>
</tr>
<tr>
<td>FIT TO LETTER</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>TEXT HEIGHT</td>
<td>SAME</td>
<td></td>
</tr>
</tbody>
</table>
## Parallel menu
This menu controls the operation of the printer's parallel data interface.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARALLEL</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>BI-DIRECTION</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>ECP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>ACK WIDTH</td>
<td>NARROW</td>
<td></td>
</tr>
<tr>
<td>ACK/BUSY TIMING</td>
<td>ACK IN BUSY</td>
<td></td>
</tr>
<tr>
<td>I-PRIME</td>
<td>3 MICRO SEC</td>
<td></td>
</tr>
</tbody>
</table>

## USB menu
This menu controls the operation of the printer's USB data interface.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>SOFT RESET</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>SPEED</td>
<td>480 Mbps</td>
<td></td>
</tr>
<tr>
<td>SERIAL NUMBER</td>
<td>ENABLE</td>
<td></td>
</tr>
</tbody>
</table>

## Network menu
This menu controls the operation of the printer's 10Base-T/100Base-TX network interface.

NOTE
This is applicable only to the B411dn model.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>IP VERSION</td>
<td>IPv4</td>
<td></td>
</tr>
<tr>
<td>NETBEUI</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>NETBIOS OVER TCP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>NETWARE</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>ETHERTALK</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>FRAMETYPE</td>
<td>AUTO</td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS SET</td>
<td>AUTO</td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>xxx.xxx.xxx.xxx</td>
<td></td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>xxx.xxx.xxx.xxx</td>
<td></td>
</tr>
<tr>
<td>GATEWAY ADDRESS</td>
<td>xxx.xxx.xxx.xxx</td>
<td></td>
</tr>
<tr>
<td>WEB</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>TELNET</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>SNMP</td>
<td>ENABLE</td>
<td></td>
</tr>
</tbody>
</table>

Operator panels > 19
Maintenance menu
This menu provides access to various printer maintenance functions.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>NETWORK SCALE</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>HUB LINK SETTING</td>
<td>AUTO NEGOTIATE</td>
<td></td>
</tr>
<tr>
<td>FACTORY DEFAULTS</td>
<td>EXECUTE</td>
<td></td>
</tr>
</tbody>
</table>

Usage menu
This menu is for information only, and provides an indication of total usage of the printer and the expected life left in its consumable items. This is particularly useful if you do not have a full set of replacement consumables to hand and you need to know how soon you will need them.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRAY1 PAGE COUNT</td>
<td>nnnn</td>
<td>An indication of the number of pages printed from Tray1.</td>
</tr>
<tr>
<td>TRAY2 PAGE COUNT</td>
<td>nnnn</td>
<td>An indication of the number of pages printed from Tray2. (When Tray2 is installed.)</td>
</tr>
<tr>
<td>MN PAGE COUNT</td>
<td>nnnn</td>
<td>An indication of the number of pages printed from the Manual Feed Tray.</td>
</tr>
<tr>
<td>DRUM LIFE</td>
<td>REMAINING%</td>
<td>An indication of the remaining drum life.</td>
</tr>
<tr>
<td>TONER (n.nK)</td>
<td>REMAINING%</td>
<td>An indication of how much toner is left in the cartridge.</td>
</tr>
</tbody>
</table>
**PRINTING MENU SETTINGS**

The menu settings can be printed as a menu map as follows.

**Using the Online button**

1. Press the **Online** button to take the printer off-line.
2. Press and hold down the **Online** button for at least four seconds, but less than seven seconds.
3. The printer prints a list of the menu settings and a demo print page. See “Online button” on page 13.

**Using the Configuration Tool**

1. Select **Start > All Programs > Okidata > Configuration Tool > Configuration Tool**. The Configuration Tool page is displayed.
2. Select this printer displayed under the Registered Device table.
3. Click **Device Setting** tab.
4. Click **Menu Setting**. You can check **Expand All** menu items or click **User Menu**.
5. Expand the Information Menu.
6. To print a demo page or Menu Map, select either **Demo1** or **Print Menu Map** and click **Execute**.
**B431d, B431dn**

**Operator Panel**

The B431d, B431dn operator panel consists of a menu driven control panel, an LCD display and two LED indicators.

**Panel Elements**

1. **Liquid crystal display.** (LCD) panel. Two rows of up to 16 alphanumeric digits displaying print status, menu items in menu mode and error messages.

2. **Menu Scroll Buttons.** Press briefly to enter the **Menu** mode. Press briefly again to select the next menu. Press for more than 2 seconds to scroll through the different menus.

3. **Back button.** Press briefly to return to the previous higher level menu item or exit the menu when in **Menu** mode. In the **Online** or **Offline** mode/Menu mode: when pressed for 4 seconds, the printer starts to shutdown.

4. **OK button.** In the **Online** or **Offline** mode: press this briefly to enter the **Menu** mode. In the **Menu** mode: press this briefly to select the menu or setting indicated on the LCD. When pressed for 2 seconds or longer, it reverts to the previous menu item.

   **Note**
   When pressed with **DATA** displayed (press and hold for five seconds), it forces the printer to print out the remaining data in the printer.

5. **Online button.** Press to switch between **Online** and **Offline** status. Press to exit the menu and displays **Online**, when in the **Menu** mode.

   **Note**
   When pressed in Menu mode, the Online button returns the printer to **Online** status. Also when there is an error indicating wrong paper size, pressing the Online button forces the printer to print.

   When manually feeding paper, pressing the Online button will start the printing.
6. **Cancel button.** When printing press to cancel a print job. Press to exit the **MENU** mode and go **ONLINE,** when in the **MENU** mode.

   **NOTE**
   When there is an error, and there are print jobs in queue, pressing the Cancel button deletes the first job in the queue.

7. **Ready indicator (green).** **ON** indicates ready to receive data. **FLASHING** indicates processing data. **OFF** indicates Offline.

8. **Attention indicator (red).** **ON** indicates a warning (e.g. low toner). **FLASHING** indicates an error, (e.g. toner empty). **OFF** indicates normal condition.
**MENU FUNCTIONS**

The Printer Menu allows you to view and change the printer’s internal settings. The settings are grouped into categories or “menus” such as Information Menu or Print Menu.

Some of these settings are similar to those found in your printer driver or application software. The settings that you can change using this software act as the printer’s defaults. These can be overridden by the settings in your printer driver or application.

For example, if you have set the number of copies in the Printer Menu settings to one, this will be overridden if you select three copies of your document in the printer driver.

Factory default settings are shown in the following tables.

### Information menu

This menu provides a quick method of listing various items stored within the printer.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>ACTION</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRINT MENU MAP</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>NETWORK</td>
<td>EXECUTE</td>
<td>B431dn only</td>
</tr>
<tr>
<td>DEMO 1</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT FILE LIST</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT PSE FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT PCL FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT PPR FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT FX FONT</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>PRINT ERROR LOG</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>USAGE REPORT</td>
<td>EXECUTE</td>
<td></td>
</tr>
</tbody>
</table>

### Shutdown menu

This menu shuts down the printer.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>ACTION</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>SHUTDOWN START</td>
<td>EXECUTE</td>
<td></td>
</tr>
</tbody>
</table>

### Print menu

This menu provides adjustment of various print job related functions.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>COPIES</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>DUPLEX</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>PAPER FEED</td>
<td>TRAY1</td>
<td></td>
</tr>
<tr>
<td>AUTO TRAY SWITCH</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>TRAY SEQUENCE</td>
<td>DOWN</td>
<td></td>
</tr>
<tr>
<td>MP TRAY USAGE</td>
<td>DO NOT USE</td>
<td></td>
</tr>
<tr>
<td>MEDIA CHECK</td>
<td>ENABLE</td>
<td></td>
</tr>
</tbody>
</table>
Media Menu
This menu provides adjustment to suit a wide range of print media.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRAY 1 PAPERSIZE</td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td>TRAY 1 MEDIATYPE</td>
<td>PLAIN</td>
<td></td>
</tr>
<tr>
<td>TRAY 1 MEDIAWEIGHT</td>
<td>MEDIUM</td>
<td></td>
</tr>
<tr>
<td>TRAY2 PAPERSIZE</td>
<td>A4</td>
<td>When tray 2 is installed</td>
</tr>
<tr>
<td>TRAY2 MEDIATYPE</td>
<td>PLAIN</td>
<td>When tray 2 is installed</td>
</tr>
<tr>
<td>TRAY2 MEDIAWEIGHT</td>
<td>MEDIUM</td>
<td>When tray 2 is installed</td>
</tr>
<tr>
<td>MPT PAPERSIZE</td>
<td>A4</td>
<td></td>
</tr>
<tr>
<td>MPT MEDIATYPE</td>
<td>PLAIN</td>
<td></td>
</tr>
<tr>
<td>MPT MEDIAWEIGHT</td>
<td>MEDIUM</td>
<td></td>
</tr>
<tr>
<td>UNIT OF MEASURE</td>
<td>MILLIMETER</td>
<td></td>
</tr>
<tr>
<td>X DIMENSION</td>
<td>210 MILLIMETER</td>
<td></td>
</tr>
<tr>
<td>Y DIMENSION</td>
<td>297 MILLIMETER</td>
<td></td>
</tr>
</tbody>
</table>

System configuration menu
This menu adjusts general printer settings to suit the way you prefer to work.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>POW SAVE TIME</td>
<td>1 MIN</td>
<td></td>
</tr>
<tr>
<td>PERSONALITY</td>
<td>AUTO EMULATION</td>
<td></td>
</tr>
<tr>
<td>PARA PS-PROTOCOL</td>
<td>ASCII</td>
<td></td>
</tr>
<tr>
<td>NET PS-PROTOCOL</td>
<td>RAW</td>
<td></td>
</tr>
<tr>
<td>USB PS-PROTOCOL</td>
<td>RAW</td>
<td>B431dn only</td>
</tr>
<tr>
<td>CLRABLE WARNING</td>
<td>ONLINE</td>
<td></td>
</tr>
<tr>
<td>AUTO CONTINUE</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>MANUAL TIMEOUT</td>
<td>60 SEC</td>
<td></td>
</tr>
<tr>
<td>TIMEOUT INJOB</td>
<td>40 SEC</td>
<td></td>
</tr>
<tr>
<td>TIMEOUT LOCAL</td>
<td>40 SEC</td>
<td></td>
</tr>
<tr>
<td>TIMEOUT NET</td>
<td>90 SEC</td>
<td>B431dn only</td>
</tr>
<tr>
<td>LOW TONER</td>
<td>CONTINUE</td>
<td></td>
</tr>
</tbody>
</table>
### PCL emulation

This menu controls the printer’s PCL emulation.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAM RECOVERY</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>ERROR REPORT</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>START UP</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>HIGH HUM. MODE</td>
<td>OFF</td>
<td>If moistened paper (<em>) is curled significantly after printing, change the setting to ON. (</em>) Moistened paper means paper that has been left in a high-humidity environment.</td>
</tr>
<tr>
<td>FONT SOURCE</td>
<td>RESIDENT</td>
<td></td>
</tr>
<tr>
<td>FONT NO.</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>FONT PITCH</td>
<td>10.00 CPI</td>
<td></td>
</tr>
<tr>
<td>SYMBOL SET</td>
<td>PC-8</td>
<td></td>
</tr>
<tr>
<td>A4 PRINT WIDTH</td>
<td>78 COLUMN</td>
<td></td>
</tr>
<tr>
<td>WHITE PAGE SKIP</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>CR FUNCTION</td>
<td>CR</td>
<td></td>
</tr>
<tr>
<td>LF FUNCTION</td>
<td>LF</td>
<td></td>
</tr>
<tr>
<td>PRINT MARGIN</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>PEN WIDTH ADJUST</td>
<td>ON</td>
<td></td>
</tr>
<tr>
<td>TRAY ID#</td>
<td>#</td>
<td></td>
</tr>
<tr>
<td>PCL T0ID</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>PCL T1ID</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>PCL T2ID</td>
<td>5</td>
<td>When Tray2 is installed</td>
</tr>
</tbody>
</table>

### PPR Emulation

This menu controls the printer’s PPR emulation.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER PITCH</td>
<td>10 CPI</td>
<td></td>
</tr>
<tr>
<td>FONT CONDENSE</td>
<td>12 CPI to 20 CPI</td>
<td></td>
</tr>
<tr>
<td>CHARACTER SET</td>
<td>SET-2</td>
<td></td>
</tr>
<tr>
<td>SYMBOL SET</td>
<td>IBM-437</td>
<td></td>
</tr>
<tr>
<td>LETTER O STYLE</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>ZERO CHARACTER</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>LINE PITCH</td>
<td>6 LPI</td>
<td></td>
</tr>
<tr>
<td>WHITE PAGE SKIP</td>
<td>OFF</td>
<td></td>
</tr>
</tbody>
</table>
FX Emulation
This menu controls the printer’s FX emulation.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHARACTER PITCH</td>
<td>10 CPI</td>
<td></td>
</tr>
<tr>
<td>CHARACTER SET</td>
<td>SET-2</td>
<td></td>
</tr>
<tr>
<td>SYMBOL SET</td>
<td>IBM-437</td>
<td></td>
</tr>
<tr>
<td>LETTER O STYLE</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>ZERO CHARACTER</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>LINE PITCH</td>
<td>6 LPI</td>
<td></td>
</tr>
<tr>
<td>WHITE PAGE SKIP</td>
<td>OFF</td>
<td></td>
</tr>
<tr>
<td>CR FUNCTION</td>
<td>CR</td>
<td></td>
</tr>
<tr>
<td>LINE LENGTH</td>
<td>80 COLUMN</td>
<td></td>
</tr>
<tr>
<td>FORM LENGTH</td>
<td>11.7 INCH</td>
<td></td>
</tr>
<tr>
<td>TOF POSITION</td>
<td>0.0 INCH</td>
<td></td>
</tr>
<tr>
<td>LEFT MARGIN</td>
<td>0.0 INCH</td>
<td></td>
</tr>
<tr>
<td>FIT TO LETTER</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>TEXT HEIGHT</td>
<td>SAME</td>
<td></td>
</tr>
</tbody>
</table>

Parallel menu
This menu controls the operation of the printer’s parallel data interface.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>PARALLEL</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>BI-DIRECTION</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>ECP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>ACK WIDTH</td>
<td>NARROW</td>
<td></td>
</tr>
<tr>
<td>ACK/BUSY TIMING</td>
<td>ACK IN BUSY</td>
<td></td>
</tr>
<tr>
<td>I-PRIME</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>OFFLINE RECEIVE</td>
<td>DISABLE</td>
<td></td>
</tr>
</tbody>
</table>
**USB menu**

This menu controls the operation of the printer’s USB data interface.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>USB</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>SOFT RESET</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>SPEED</td>
<td>480Mbps</td>
<td></td>
</tr>
<tr>
<td>OFFLINE RECEIVE</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>SERIAL NUMBER</td>
<td>ENABLE</td>
<td></td>
</tr>
</tbody>
</table>

**Network menu**

This menu controls the operation of the printer’s 10Base-T/100Base-TX network interface.

*NOTE*
*This is applicable only to the B431dn model.*

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TCP/IP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>IP VERSION</td>
<td>IPv4</td>
<td></td>
</tr>
<tr>
<td>NETBEUI</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>NETBIOS OVER TCP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>NETWARE</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>ETHERTALK</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>FRAMETYPE</td>
<td>AUTO</td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS SET</td>
<td>AUTO</td>
<td></td>
</tr>
<tr>
<td>IP ADDRESS</td>
<td>xxx.xxx.xxx.xxx</td>
<td></td>
</tr>
<tr>
<td>SUBNET MASK</td>
<td>xxx.xxx.xxx.xxx</td>
<td></td>
</tr>
<tr>
<td>GATEWAY ADDRESS</td>
<td>xxx.xxx.xxx.xxx</td>
<td></td>
</tr>
<tr>
<td>WEB</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>TELNET</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>FTP</td>
<td>DISABLE</td>
<td></td>
</tr>
<tr>
<td>SNMP</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>NETWORK SCALE</td>
<td>NORMAL</td>
<td></td>
</tr>
<tr>
<td>HUB LINK SETTING</td>
<td>AUTO NEGOTIATE</td>
<td></td>
</tr>
<tr>
<td>FACTORY DEFAULTS</td>
<td>EXECUTE</td>
<td></td>
</tr>
</tbody>
</table>
Maintenance menu

This menu provides access to various printer maintenance functions.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>MENU RESET</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>SAVE MENU</td>
<td>EXECUTE</td>
<td></td>
</tr>
<tr>
<td>POWER SAVE</td>
<td>ENABLE</td>
<td></td>
</tr>
<tr>
<td>PAPER BLACK SET</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>DARKNESS</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>SMR SETTING</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>BG SETTING</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>

Usage menu

This menu is for information only, and provides an indication of total usage of the printer and the expected life left in its consumable items. This is particularly useful if you do not have a full set of replacement consumables to hand and you need to know how soon you will need them.

<table>
<thead>
<tr>
<th>ITEM</th>
<th>DEFAULT</th>
<th>REMARKS</th>
</tr>
</thead>
<tbody>
<tr>
<td>TRAY1 PAGE COUNT</td>
<td>nnnn</td>
<td>An indication of the number of pages printed from Tray1.</td>
</tr>
<tr>
<td>TRAY2 PAGE COUNT</td>
<td>nnnn</td>
<td>An indication of the number of pages printed from Tray2. (When Tray2 is installed.)</td>
</tr>
<tr>
<td>MPT PAGE COUNT</td>
<td>nnnn</td>
<td>An indication of the number of pages printed from the MPT.</td>
</tr>
<tr>
<td>DRUM LIFE</td>
<td>REMAINING%</td>
<td>An indication of the remaining drum life.</td>
</tr>
<tr>
<td>TONER (n.nK)</td>
<td>REMAINING%</td>
<td>An indication of how much toner is left in the cartridge.</td>
</tr>
</tbody>
</table>

PRINTING MENU SETTINGS

Current menu settings can be confirmed by printing a Menu Map, using the control panel.

NOTE
This is applicable only to B431d, B431dn models.

1. Press the Menu UP arrow or DOWN arrow button until the INFORMATION MENU is available, then press the OK button.
2. Press the UP arrow or DOWN arrow button until PRINT MENU MAP EXECUTE is displayed.
3. Press the OK button to print the menu map.
4. Press the Cancel or Online or the BACK button repeatedly to exit the MENU mode.
PAPER RECOMMENDATIONS

For guidance on the media you can use with your printer, which input tray and which ejection method to use, see the section entitled “Paper and tray information” in the “Specifications” chapter.

NOTE
The reference to Manual Feed Tray is for the B411d, B411dn models and the Multi Purpose Tray is for the B431d, B431dn models.

PAPER AND ENVELOPE TYPES

The manufacturer of this printer recommends the following guidelines when selecting paper and envelopes for use in your printer:

- Paper and envelopes should be stored flat and away from moisture, direct sunlight and heat sources.
- Use a smooth finished paper such as copier or laser type paper with a Sheffield (smoothness) rating of 250 or less. If in doubt, please ask your paper supplier.
- Use paper and envelopes that are designed for use in laser type printers.
- The use of heavily laid or textured paper will seriously impact on the life of the image drum.
- Do not use very smooth, shiny/glossy paper.
- Do not use heavily embossed headed paper.
- Do not use specially treated papers such as carbon paper, non-carbon paper, thermal paper and impact paper.
- Avoid using paper with perforations, cut-outs and ragged edges.
- Do not use envelopes with windows or metal clasps.
- Do not use envelopes with self sealing flaps.
- Avoid using damaged or curled envelopes.

TRANSPARENCIES AND ADHESIVE LABELS

The manufacturer of this printer recommends the following guidelines when selecting transparencies and adhesive labels for use in your printer:

- Always manually feed single sheets using a Manual Feed Tray or Multi Purpose Tray.
- Always use rear output.
- Media must be designed for use in laser printers or photocopiers and must be able to withstand 200°C for 0.1 sec.
- Do not use media designed for use in colour laser printers and photocopiers.
- Labels should cover entire carrier sheet.
- Carrier sheet or adhesive must not be exposed to any part of the printer.

NOTE
You can use Thermal resistant transparencies used for Over Head Projectors.
**POSTCARDS**

The manufacturer of this printer recommends the following guidelines when selecting postcards for use in your printer:

- Always manually feed single postcards using the Manual Feed Tray or Multi Purpose Tray, depending on your printer model.
- Use unfolded double postcards.
- Use postcards designed for use in laser type printers.
- Do not use postcards used for ink jet printers.
- Do not use stamped or picture postcards.

**INSTALLING PAPER**

**PAPER TRAY**

*NOTE*

If you are topping up the paper in a paper tray, it is recommended that you remove the remaining paper from the tray first then add the new paper stock followed by the paper you removed. This ensures that the oldest paper is used first to help prevent paper jams.

1. Remove the paper tray from the bottom of the printer and place plain paper (1) in the tray, keeping the level of the paper in the tray below the paper full guide arrowheads shown on the paper guides (2).

*NOTE*

Load letter headed paper face down and top edge towards the front of the paper tray (3).
2. Adjust the rear paper support (4) to the size of paper you are using by gripping the lug, tilting and sliding the support forwards or backwards as necessary.

3. Adjust the paper guides (5) by gripping the lug and moving it backwards or forwards to match the size of the paper used. It is important to adjust the paper guides correctly to ensure that the paper is not skewed in the print process. Paper jams may occur if this operation is not carried out correctly.

4. Replace the tray in the printer.

**NOTE**
If you have the optional second paper tray (Tray 2) and you are printing from the first (upper) tray (Tray 1), you can pull out the second (lower) tray to reload it. However, if printing from the second (lower) tray, do not pull out the first (upper) tray as this will result in a paper jam.

**Face up and face down printing**

For face down printing, make sure the Rear stacker is closed (the paper exits from the top of the printer). The Output Stacker on the top of the printer stacks printed pages face down, capacity 150 sheets of weight 80g/m². Pages printed in reading order (page 1 first) will be sorted in reading order (last page on top, facing down).

The face up stacker should be opened and the tray extension pulled out when required for use. (With the face up stacker either opened or closed, the driver setting of face down will successfully direct prints to the face down stacker.)

The face up stacker can hold up to 100 sheets 80g/m² standard paper.

Always use this stacker in conjunction with the Manual Feed Tray, Multi Purpose Tray or for heavyweight stocks to reduce the possibility of paper jams.

See “Paper and tray information” on page 76.

**Automatic feed sequence**

With no optional feed trays installed, the Autotray function in the Print Menu is set by default to ON and the Tray sequence function is set to DOWN. In this way, if a tray runs out of paper, automatic feed will take place in the order Tray 1, Tray 2 (if fitted), Multi Purpose Tray or the Manual Feed Tray, provided that these trays are set up for identical media. Also, configure the media size and media weight for the respective trays in the operator panel or Configuration tool, depending on your printer model.
MULTI PURPOSE TRAY AND MANUAL FEED TRAY

1. **B431**: Pull down the Multi Purpose Tray (1), extend the tray (2) and fold out the paper supports (3), and adjust the paper guides to the width of the paper (4).

   **B411**: Pull down the Manual Feed Tray (1), and adjust the paper guides (2) to the width of the paper.

2. **B431**: Load the paper into the Multi Purpose Tray and push the set button (5). Ensure that the paper is loaded below the arrow level (6) to avoid paper jam.

   **B411**: Load single sheet at a time into the Manual Feed Tray.

   **NOTE**
   
   *Do not exceed the paper capacity of approximately 100 sheets or 10 envelopes depending on the media weight.*

   **B411**: Load single sheet at a time into the Manual Feed Tray.

   For single-sided printing on headed paper load the paper with the pre-printed side up and top edge into the printer.

   For two-sided (duplex) printing on headed paper, load the paper with the pre-printed side down and top edge away from the printer.
> Envelopes should be loaded flap down, face up with the top edge to the left and short edge into the printer.

**NOTE**
*Do not select Duplex printing on envelopes.*

> Load Transparencies face up and top edge into the printer.

> For heavyweight paper or cardstock open the rear stacker to collect the printed output. This will give the paper a nearly straight path through the machine, avoiding paper jams and damage to the paper.

3. **B431**: If required, set the media size and orientation in the media menu using the control panel, then issue the print command.  
   **B411**: If required, set the media size and orientation in the Configuration tool, then issue the print command.

---

**CAUTION!**

Damage to the printer may occur if the incorrect paper setting is used when printing on a different media.

---

**NOTE**

- You can also set the media type in your printer driver. However, the printer driver settings will override the settings on the control panel or Configuration Tool.
- Remember to reset the printer for normal paper after printing on a different media.

---

**PAPER FEED, SIZE AND MEDIA SETTING**

The process used to fuse (fix) the printed image to the paper involves a mixture of pressure and heat. Too much heat will cause lightweight paper to crease or curl and corrugations in transparencies. Too little heat will cause the image not to fuse fully into heavyweight paper.

**NOTE**

Although media properties can be set in the printer driver for particular jobs, when filling a tray with media it is recommended that you manually set the printer to match the media as described here.

---

**B411d, B411dn**

You can change the media type as follows:

1. Start the Configuration tool.
2. Expand the **User Menu** to list the options.
3. Expand the **Media Menu** to list the options.
4. Click on the paper tray being used. Adjust the media type to the required setting and, if necessary, the paper size to the size of the paper being used.
5. Click **Save to Device** ⬇️ icon, to save the new settings.
6. Click OK.
B431d, B431dn

Using the control panel on your printer, you can choose:

> which paper to use
> the size of the paper you wish to use
> the weight of the paper (thickness)
> the type of paper

---

**NOTE**
> If the settings in the printer differ from those selected on your computer, the printer will not print and the LCD will display an error message.
> The following printer settings are given as a guide only. Some software applications require the paper feed, size and media settings to be selected from within the application (page setup).
> Although media properties can be set in the printer driver for particular jobs, it is recommended that when filling a tray with media you manually set the printer to match the media as described here.

---

**Paper feed selection**

The paper feed, paper size, paper weight and media type can be set manually on the printer using the control panel as follows.

1. Press the **Menu** UP arrow or DOWN arrow button repeatedly until PRINT MENU is displayed, then press the OK button.
2. Press the UP arrow or DOWN arrow button until PAPER FEED is displayed, then press the OK button.
3. Press the UP arrow or DOWN arrow button until the required paper feed is displayed.
4. Press the OK button. An asterisk (*) appears next to the selected paper feed.
5. Press the **Cancel** or **Online** or the BACK button repeatedly to exit the MENU mode.

---

**NOTE**

When the AUTO TRAY SWITCH is set to ON and more than one paper tray is fitted, paper feed automatically switches to the next available paper tray, providing non-stop printing.

---

**Paper size**

Set the paper size as follows.

---

**NOTE**

> When using paper trays, standard paper sizes are recognised automatically with CASSETTE SIZE (default setting) selected. Paper size need only be set for custom paper sizes.
> When using the Multi Purpose Tray, the paper size has to be selected.

1. Press the **Menu** UP arrow or DOWN arrow button until PRINT MENU is displayed, then press OK button.
2. Press either UP arrow or DOWN arrow button repeatedly until EDIT SIZE is displayed, then press OK button.
3. Press either UP arrow or DOWN arrow button until the required paper size is displayed, then press the OK button. An asterisk (*) appears next to the selected paper size.
4. Press the **Cancel** or **Online** or the BACK button repeatedly to exit the **MENU** mode.

5. Select the correct paper settings in the printer driver before printing the file.

**Media type and weight**

Set media type and weight as follows:

---

**CAUTION!**

If media type or media weight are not correctly set, print quality deteriorates and the fuser roller may be damaged.

1. Press the **Menu** UP arrow or DOWN arrow button until **MEDIA MENU** is displayed, then press the OK button.

2. Press the UP arrow or DOWN arrow button until **MEDIA TYPE** or **MEDIA WEIGHT** for the required tray is displayed, then press OK button.

3. Press the UP arrow or DOWN arrow button until the required paper type or weight is displayed, then press the OK button. An asterisk (*) appears next to the selected paper type or weight.

4. Press the **Cancel** or **Online** or the BACK button repeatedly to exit the **MENU** mode.

5. Select the correct paper settings in the printer driver before printing the file.
INTERFACES

Your printer is equipped with a selection of data interfaces:

1. **Parallel** – For direct connection to a PC. This port requires a bi-directional (IEEE 1284 compliant) parallel cable.

2. **USB** – For connection to a PC running Windows 2000 or later or Mac OS X or later. This port requires a cable conforming to USB version 2.0 or above.

   The operation of a printer is not assured if a USB compatible device is connected concurrently with other USB-compatible machines.

   When connecting multiple printers of the same type, they appear as ***** (2), ***** (3), etc. These numbers depend on the order of connecting or turning on each printer.

3. **LAN** – For network cable connection. This port is standard on the B411dn and B431dn.

   **NOTE**
   
   > It is not recommended that you connect serial/USB and parallel cables to the printer simultaneously.
   
   > Interface cables are not supplied with your printer.

If you are connecting your printer directly to a stand alone computer proceed to the chapter entitled "Printer Drivers".

If your printer is to be installed as a network printer, please refer to the relevant section in the User’s Guide for the network interface card for further details on how to configure the network connection before installing the printer drivers.

**NOTE**

Administrator’s authority is required when installing a network connection.
**PRINTER DRIVERS**

This chapter describes how to install a printer driver on two types of operating system – Windows and Macintosh.

The printer drivers are all contained on the printer driver CD. Please refer to the readme file on this CD for the latest information on printer driver installation.

**WINDOWS OPERATING SYSTEMS**

1. With Windows running, insert the printer driver CD into your CD-ROM drive.
2. If the CD does not run automatically, use Start > Run... and enter E:\setup (where E is your CD-ROM drive) in the Open field.
3. Click on OK.
4. Select your printer model.
5. Click on Driver Installation > Install Printer Driver and follow the on-screen prompts to complete your printer driver installation.
6. For the B411d, B411dn only, once the driver has been installed, install the Configuration tool. Follow the on-screen instructions to complete the Configuration tool installation.

**NOTE**

Take time to note the facilities available on the CD. For example, the Help facility briefly describes each of the Software Utilities.

7. For the B431d, B431dn once the driver has been installed, the operator panel language switching utility will run automatically. Choose your preferred operating language. See “Changing language” on page 14.

**INSTALLED OPTIONS**

Certain options may have been installed in your printer. For those that are installed, check that they appear enabled on the Menu Map.

Ensure that your options are set up in the printer driver(s) by making the appropriate settings on the Device Options tab (PCL emulation) and/or Device Settings tab (PS emulation) described in the chapter entitled “Operation”.

**MACINTOSH OPERATING SYSTEMS**

Please refer to the readme file on CD for details on installing the appropriate Macintosh drivers.

**INSTALLED OPTIONS**

Ensure that any installed options are enabled in the printer driver.

**CHOOSING A MAC DRIVER**

The B411 models allow you to use only a PCL Mac driver.

The B431 models can also use a PS driver on Macintosh operating systems.
**OPERATION**

This chapter provides a broad outline of how to operate your printer from either a Windows or a Macintosh environment. In the former, while PCL emulation is available on all printer models, PS emulation is optional on the B431d, B431dn models.

**PRINTER SETTINGS IN WINDOWS**

The operator panel controlled menus and Configuration Tool (described in the chapter entitled “Operator panels”) provide access to many options.

The Windows printer driver also contains settings for many of these items. Where items in the printer driver are the same as those in the operator panel and Configuration Tool menus, and you print documents from Windows, the settings in the Windows printer driver will override those settings in the operator panel and Configuration Tool menus.

**PRINTING PREFERENCES IN WINDOWS APPLICATIONS**

When you choose to print your document from a Windows application program a Print dialogue box appears. This dialogue usually specifies the name of the printer on which you will print your document. Next to the printer name is a **Properties** button.

When you click **Properties** a new window opens which contains a short list of the printer settings available in the driver, which you can choose for this document. The settings available from within your application are only those which you may want to change for specific applications or documents. Settings you change here will usually only last for as long as the particular application program is running.

**PCL EMULATION**

The tabs available are the **Setup Tab**, the **Job Options Tab** and the **Image Tab**.

---

*NOTE*

The illustrations in this guide relate to Windows XP PCL and PS emulations – other operating system windows may appear slightly different but the principles are the same.
1. Paper size should be the same as the page size of your document (unless you wish to scale the printout to fit another size), and should also be the same as the size of paper you will feed into the printer.

2. You can choose the source of the paper to feed, which may be Tray 1 (the standard paper tray), Manual Feed Tray (B411d, B411dn), Tray 2 (if you have the optional second paper tray installed) or the Multi Purpose Tray (B431d, B431dn). You can also click on the appropriate part of the screen graphic to select your preferred tray.

3. A variety of document finishing options can be selected, such as normal one page per sheet, or N-up (where N can be 2 or 4) for printing scaled down pages at more than one page per sheet.

4. Under 2-sided Printing, you can choose from auto or manual. Under manual 2-sided Printing you can choose to print on one side of a sheet only or to use 2-sided printing (duplex printing). Your printer allows you to carry out manual duplex printing, meaning you must pass the paper through the printer twice. For more information, see “2-sided printing” on page 49. The Duplex Help button also offers guidelines on how to carry out manual duplex printing.

5. If you have changed some printing preferences before and saved them as a set, you can recall them to avoid having to set them individually each time you need them.

6. A single on-screen button restores the default settings.
1. The output resolution of the printed page can be set as follows.
   > The ProQ1200 setting for B411d and B411dn prints at 2400 x 600dpi. This setting requires the most printer memory and takes the longest to print. Your printed pages can be scaled to fit larger or smaller stationery. It is the best option for printing photographs.
   > The High Quality setting prints at 1200 x 600dpi for B411d, B411dn and 1200 x 1200dpi for B431d, B431dn is the best option for printing vector objects such as graphics and text.
   > The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs.
   > The Draft setting prints at 300 x 300dpi and is suitable for printing draft documents that contain mainly text. You can select Toner Saving to save toner for some print jobs.

2. Page orientation can be set to either portrait (tall) or landscape (wide). Both views can be rotated by 180 degrees.

3. You can print watermark text behind the main page image. This is useful for marking documents as draft, confidential, etc.

   If you would like to print on special stationery, such as forms and letterhead, but do not want to use pre-printed stationery, you can create your own using Overlays (for B431d, B431dn). For more information on Overlays and Macros refer to "Overlays and Macros (Windows only)" on page 53. The Overlays button also offers guidelines on how to carry out manual duplex printing.

4. In Raster (bitmap) mode, processing of the page image is done in the computer leaving little processing for the printer to do, although the file size may be large. In Vector mode, file sizes may be smaller and so transmission over a network, for example, may be faster. These effects are more pronounced for graphics printing than for text printing.

5. You can select up to 999 copies to print consecutively, although you will need to top up the paper tray during such a long print run.
6. Your printed pages can be scaled to fit larger or smaller stationery, within a range of 25% to 400% of the original size.

7. A single on-screen button restores the default settings.

**Image tab**

1. Dithering produces an intermediate greyscale by adjusting the combination of dots used in printing. Selecting a setting determines the degree of detail with which a graphics image will be printed. Mesh determines that a screen of dots is used for dithering while Line Art determines that an array of lines is used for dithering.

2. Select dithering texture by setting the size of dots used in the halftone screen.

3. Set this control to print greyscale effects in black without dithering. Select the check-box to disable greyscale printing or de-select the check-box to enable greyscale printing.

4. You can manually adjust lightness (the higher the setting the lighter the print) and contrast (the higher the setting the greater the contrast).

5. A single on-screen button restores the default settings.
**PS EMULATION**

The tabs available are the **Layout Tab**, the **Paper/Quality Tab** and the **Job Options Tab**.

**Layout tab**

1. Page orientation can be set to portrait (tall), landscape (wide) or landscape rotated by 180 degrees.
2. Print on both sides (duplex printing) can be set to long edge or short edge of the document.
3. Printed page order can be set as front to back or back to front of the document.
4. Set the number of pages to be printed on a single sheet. You can also set it to print a booklet.
5. Click the **Advanced** button to be able to set further document options as follows:
1. Select the required printed paper size.
2. You can substitute another font for TrueType Font.
3. You can set other document options as required, including PostScript options and printer features.

**Paper/Quality tab**

![Paper/Quality tab screenshot](image)

You can set the paper source or leave it as automatic selection and by using the **Advanced** button you have access to the same set of options as described above for the Layout Tab.

**Job options tab**

![Job options tab screenshot](image)

1. The output resolution of the printed page can be set as follows.
   - The High Quality setting prints at 1200 x 1200dpi for B431d, B431dn is the best option for printing vector objects such as graphics and text.
   - The Normal setting prints at 600 x 600dpi and is suitable for most printing jobs. You can select Toner Saving to save toner for some print jobs.
2. You can print watermark text behind the main page image. This is useful for marking documents as draft, confidential, etc.

If you would like to print on special stationery, such as forms and letterhead, but do not want to use pre-printed stationery, you can create your own using Overlays (for B431d, B431dn). For more information on Overlays and Macros, refer to “Overlays and Macros (Windows only)” on page 53. The Overlays button also offers guidelines on how to carry out manual duplex printing.

3. You can select up to 999 copies to print consecutively, although you will need to top up the paper tray during such a long print run.

4. Your printed pages can be scaled to fit larger or smaller stationery.

5. Using the Advanced button gives you access to the facility to set mirror image printing and negative image printing.

6. A single on-screen button restores the default settings.

**Setting from Windows Control Panel**

When you open the driver properties window directly from Windows, rather than from within an application program, a somewhat more extensive range of settings is provided. Changes made here will generally affect all documents you print from Windows applications, and will be remembered from one Windows session to the next.

**PCL emulation**

The main tabs are the **General Tab**, **Advanced Tab** and **Device Options Tab**.

**General tab**

1. This area lists some of the main features of your printer, including optional items.

2. This button opens the same windows as described earlier for items which can be set from within application programs. Changes you make here, however, will become the new default settings for all Windows applications.
3. This button prints a test page to ensure that your printer is working.

NOTE
The above features are provided by the Windows XP operating system and will vary with other operating systems.

Advanced tab

1. You can specify which times of day your printer will be available.
2. Indicates current priority, from 1 (lowest) to 99 (highest). Highest priority documents will print first.
3. Specifies that documents should be spooled (stored in a special print file) before being printed. The document is then printed in the background, allowing your application program to become available more quickly. Options follow:

   This specifies that printing should not start until the last page has been spooled. If your application program needs a lot of time for further computation in the middle of printing, causing the print job to pause for more than a short period, the printer could prematurely assume that the document has finished. Selecting this option would prevent that situation, but printing will be completed a little later, as the start is delayed.

   This is the opposite choice to the one above. Printing starts as soon as possible after the document begins spooling.

4. This specifies that the document should not be spooled, but printed directly. Your application will not normally be ready for further use until the print job is complete. This requires less disk space on your computer, since there is no spool file.
5. Directs the spooler to check the document setup and match it to the printer setup before sending the document to print. If a mismatch is detected, the document is held in the print queue and does not print until the printer setup is changed and the document restarted from the print queue. Mismatched documents in the queue will not prevent correctly matched documents from printing.
6. Specifies that the spooler should favour documents which have completed spooling when deciding which document to print next, even if completed documents are lower priority than documents which are still spooling. If no documents have completed spooling, the spooler will favour larger spooling documents over shorter ones. Use this option if you want to maximise printer efficiency. When this option is disabled the spooler chooses documents based only on their priority settings.
7. Specifies that the spooler should not delete documents after they are completed. This allows documents to be re-submitted to the printer from the spooler instead of printing again from the application program. If you use this option frequently it will require large amounts of disk space on your computer.

8. Specifies whether advanced features, such as pages per sheet, are available, depending on your printer. For normal printing keep this option enabled. If compatibility problems occur you can disable the feature. However, these advanced options may then not be available, even though the hardware might support them.

9. This button provides access to the same setup windows as when printing from applications. Changes made via the Windows Control Panel become the Windows default settings.

10. You can design and specify a separator page that prints between documents. This is particularly useful on a shared printer to help each user find their own documents in the output stack.

---

**NOTE**
The above features are provided by the Windows XP operating system and will vary with other operating systems.

---

**Device options tab**

In this window you can select which optional upgrades are installed on your printer. See the chapter entitled “Installing options”.
PS emulation

The main tabs are the **General Tab**, **Advanced Tab** and **Device Settings Tab**. The General and Advanced tabs are the same as for PCL emulation described earlier.

**Device settings tab**

1. You can set the desired paper sizes in each of the available paper feed trays.
2. You can make a variety of font settings depending on your application.
3. You can set which optional upgrades are installed on your printer. See the chapter entitled “Installing options”.

**PRINTER SETTINGS IN MACINTOSH**

Refer to the readme file on the drivers CD, and the online help provided in the driver software.
2-SIDED PRINTING

The duplex unit adds the function of two-sided printing, using less paper and making large documents easier to handle. It also enables booklet printing, which uses even less paper.

You can print using Auto Duplex or Manual Duplex function.

NOTE
The steps in the process relate to Windows XP PCL. Other operating system windows may appear slightly different, but the principles are the same.

AUTO DUPLEX PRINTING

This printer provides automatic two-sided printing only for Letter, A4, B5, Executive, Legal 13, 13.5, 14 and 16K, using paper stocks from 60 - 122g/m².

To carry out Auto Duplex Printing:

1. Select File > Print and click the Properties button.
2. Select the input tray (Tray1, Tray2 (optional), Multi Purpose Tray (B431d, B431dn) or Manual Feed Tray (B411d, B411dn)) from the Source drop down.
3. In the Duplex printing drop down menu, select either Long Edge (Auto) or Short Edge (Auto) according to your printing preferences.
4. If you require further information, click the Duplex Help button.
5. Click the Print button.

MANUAL DUPLEX PRINTING USING THE PAPER TRAY (Windows only)

To carry out 2-sided, or Manual Duplex Printing you must pass paper through the printer twice. You can carry out 2-sided printing using the Paper Tray or the Manual Feed Tray (B411d, B411dn) or the Multi Purpose Tray (B431d, B431dn). You can use A4, A5, A6, B5, Letter, Legal 13, 13.5 and 14, Statement, Executive, 16K and Custom paper sizes, using paper stocks from 60 - 122g/m².

NOTE
Manual Duplex printing is available only for Windows PCL Driver.

To carry out 2-sided, or Manual Duplex Printing you must pass paper through the printer twice. You can carry out 2-sided printing using the Paper Tray or the Manual Feed Tray (B411d, B411dn) or the Multi Purpose Tray (B431d, B431dn). You can use A4, A5, A6, B5, Letter, Legal 13, 13.5 and 14, Statement, Executive, 16K and Custom paper sizes, using paper stocks from 60 - 122g/m².

NOTE
> You cannot use A6 paper size for printing from Tray 2 (option).
> You can print on Legal 13.5 paper only from Tray1, optional Tray2 and when using Auto Duplex function.

1. Ensure that there is enough paper in the Paper Tray to carry out the print job.
2. Select File > Print and click the Properties button.
3. Select Tray1 from the Source drop down.
4. In the 2-sided printing drop down menu, select either Long Edge (Manual) or Short Edge (Manual) according to your printing preferences. If you require further information, click the Duplex Help button. Then, Click the Print button.

5. Every second page (1) of your document is printed first. When this is complete, a message appears on screen prompting you to take the paper, flip it and replace it in the Paper Tray.

6. Open the Paper Tray (2).
7. Take the printed paper from the Output Stacker (3) and place it in the Paper Tray, ensuring that the printed side is facing up and the bottom of the page facing into the printer (4).

8. Close the Paper Tray and press the Online (5) button. The message window should disappear from your screen and the document finishes printing the remaining pages of your document.

NOTE
You must press the Online button to start the printing for other side. The default time is set to one minute, failing which, the data is deleted and not printed.

MANUAL DUPLEX PRINTING USING THE MANUAL FEED TRAY (B411d, B411dn)

NOTE
> When using the Manual Feed Tray, feed pages one sheet at a time.
> Use the Multi Purpose Tray for Manual Duplex Printing for B431d, B431dn, but the principles are the same, See "Multi purpose tray and manual feed tray" on page 33.

1. Position the paper guides on the Manual Feed Tray according to the paper size.
2. Place paper one sheet at a time in the Manual Feed Tray. The paper is automatically gripped in position.
3. Select File > Print to display the Print dialog box.
4. Click the Properties button.
5. Select the Manual Feed Tray from the Source drop down.
6. On the 2-sided printing drop down menu, select either Long Edge (Manual) or Short Edge (Manual) according to your printing preferences. If you require further information, click the Duplex Help button.
7. When every second page has printed, take the paper from the output stacker.

8. Set the paper one page at a time in the Manual Feed Tray with the printed side facing down and the top of the page facing into the printer. Ensure that the paper is gripped in place.

9. Press the **Online** button. The remaining pages of your document print on the blank side of the paper, one sheet at a time as you feed it into the Manual Feed Tray.
OVERLAYS AND MACROS (WINDOWS ONLY)

WHAT ARE OVERLAYS AND MACROS?

If you would like to print on special stationery, such as forms and letterhead, but do not want to use pre-printed stationery, you can create your own using these advanced features.

You can use PostScript overlays to generate all your special stationery and store it in the printer for use whenever you need it. If you have chosen to install the PCL driver, macros perform a similar function.

You can create several overlays or macros, and combine them in any way you like to produce a variety of forms and other special stationery. Each image can be printed on just the first page of a document, on all pages, on alternate pages, or just the pages that you specify.

CREATING POSTSCRIPT OVERLAYS

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer (.PRN) file.
2. Use the Storage Device Manager utility software supplied on CD with your printer to create a “project file,” import the .PRN file(s), and download the generated filter (.HST) file to the printer. The project file will contain one or more overlay images which are functionally related, such as the cover page and the continuation page images for business letters.
3. Use downloaded files to define your overlays ready for use when printing your documents.

When printing overlay files to disk, do not select any special features, such as two-sided printing or multiple copies. These are not appropriate to overlays, they apply only to your final documents.

CREATING THE OVERLAY IMAGE

1. Use your preferred application, perhaps a graphics program, to create the required overlay image and save it.
2. Open your application’s Print… dialogue.
3. Make sure that the selected printer name (1) is that of your PostScript printer driver.
4. Select the Print To File (2) option.
5. Click the Properties button (3) to open the Document Properties window.
6. On the Overlay tab, choose Create Form from the drop-down list (4).
7. Click OK to close the Document Properties window.
8. Click OK again to close the Print dialogue.
9. When prompted for a print file name, enter a meaningful name with the extension.PRN.
10. Close your application.
CREATE AND DOWNLOAD THE PROJECT

1. From the Windows Start menu, start Storage Device Manager (SDM) and allow SDM to discover the printer.

2. Choose Projects > New Project.

3. Choose Projects > Add File to Project.

4. Set the Files of Type drop-down list to PRN Files(*.prn).

5. Navigate to the folder where the .PRN files are stored and select one or more of these to include in your overlay set.

   You can have more than one printer (.PRN) file in a project. For example, one for top pages and another for continuation pages. Use standard Windows techniques (Shift or Ctrl keys) to select multiple files simultaneously if you need to.

6. Click Open to add these files to the current project.

7. When a message box appears confirming that a filter file has been created, click OK to clear the message.

8. The project window will display one. HST file for each printer file added. Make a careful note of each of these names. Ensure that you note them exactly as they appear, they are case sensitive, and you will need them later.

9. Choose Projects > Save Project and enter a meaningful name (e.g. “Letter Stationery”) so that you can recognise it later if you want to modify it.

10. Choose Projects > Send Project Files to Printer to download the project to the printer.

   If you have a hard disk in the printer, SDM will automatically download files to it. If not, SDM will download files to flash memory. If you have a hard disk but still prefer to download to flash memory, double-click the file name in the Project window and under Volume, type in %Flash0% and then click OK.

11. When the message “Command Issued” appears confirming that the download is complete, click OK to clear the message.

TEST PRINTING THE OVERLAY

1. Click on the printer icon for the relevant printer and choose Printers → Test Form.

2. In the Test PostScript Form window, to test each overlay select it and click OK. There will be a short pause while the printer processes the form, and then it will print.

3. When each overlay has been tested, click Exit.

4. Click the standard Windows Close (X) button, or choose Projects > Exit to close Storage Device Manager.

DEFINING OVERLAYS

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the Start menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose Printing Preferences from the pop-up menu.

3. On the Overlay tab, click the New button.
4. In the **Define Overlays** window, enter a suitable name (2) for this overlay and choose which page(s) (3) of your documents will use this overlay.

5. Enter the name of the overlay file (4) exactly as it appeared in the Storage Device Manager project window. Remember that this name is case sensitive.
   If you forgot to note the overlay names when you created them, you can find them using Storage Device Manager to view the project file, or the printer's Information Menu to print a file list and identify them from there.

6. Click **Add** (5) to add this overlay into the defined overlays list.

7. Click **OK** to close the Define Overlay window.
   The new overlay now appears in the Defined Overlays list in the printer properties window.

8. Repeat the above procedure if you wish to define more overlays.

9. When done, click **OK** to close the printer properties window.
   Your new overlays are now ready and available to be used for any future documents you wish.

**Printing with PostScript overlays**

Once you have defined your overlays you are ready to use them for any documents you wish. The example illustrated here uses two overlays for business letters. The first prints on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. Remember, if necessary, to format the document so that it will fit within the appropriate space.

2. Open your application’s **Print…** dialogue and choose any options you will require, ensuring that the target printer is your PostScript printer driver in which the overlays have been defined.

3. Click the **Properties** button to open the Printing Preferences window.

4. On the Overlays tab, choose **Use Overlay** from the drop-down list (1).

5. Click on the first overlay (2) you wish to use. In this example it is the Cover Page overlay. Then click the **Add** button (3).

6. If you want to use another overlay, in this case it is the Continuation page, click the second overlay (4) and then click the **Add** button (3) again.

7. When you have selected all the overlays you want to use for this document, click **OK**.

8. Finally, in your application’s print dialogue, click **OK** to begin printing.
**CREATING PCL OVERLAYS**

Three steps are required to create an overlay:

1. Create the form data using your own application software and print it to a printer (.PRN) file.
2. Use the Storage Device Manager utility software supplied on CD with your printer to create a “project file,” import the .PRN file, and download the generated filter (.BIN) files to the printer.
3. Use downloaded files to define your overlay ready for use with any future document.

When printing files to disk, do not select any special features, such as two-sided printing or multiple copies. These are not appropriate to macros, they apply only to your final documents.

**CREATING THE OVERLAY IMAGE**

1. Use your preferred application, perhaps a graphics program, to create the required image and save it.
2. Open your application’s **Print...** dialogue.
3. Make sure that the selected printer name (1) is that of your PCL printer driver.
4. Select the **Print To File** (2) option.
5. When prompted for a print file name, enter a meaningful name with the extension .PRN.
6. Close your application.

**CREATE AND DOWNLOAD MACROS**

1. From the Windows **Start** menu, start **Storage Device Manager** (SDM) and allow SDM to discover the printer.
2. Choose **Projects > New Project** to start a new project.
3. Choose **Projects > Filter Macro File**. The Filter Printer Patterns dialogue box appears. Make any adjustments in the settings that you need and then click **OK**.
   
   **Example:** If you create a black oval in MS Paint and leave all the colour command filters checked, the black oval will print as a black rectangle when the overlay is used. To maintain the oval shape, turn off (deselect) the “Configure Image Data,” “Palette ID” and “Palette Control” filters.
4. Set the **Files of Type** drop-down list to **PRN Files (*.prn)**.
5. Navigate to the folder where the overlay .PRN files are stored and select one or more of these to include in your overlay set.
   
   You can have more than one macro file in a project. For example, one for top pages and another for continuation pages. Use standard Windows techniques (Shift or Ctrl keys) to select multiple files simultaneously if you need to.
6. Click **Open** to add these files to the current project. (You can also drag and drop files from Windows Explorer directly into the project window if you prefer.) When a message box appears confirming that a filter file has been created, click **OK** to clear the message.
7. The project window will display one .BIN file for each printer file added. Make a careful note of the name and ID number for each of the files. You will need them later.
If you wish to edit the names or ID numbers, double-click the file entry and edit the details.

Note that the names are case sensitive.

8. Choose **Projects > Save Project** and enter a meaningful name (e.g. “Letter Stationery”) so that you can recognise it.

9. Choose **Projects > Send Project Files to Printer** to download the project to the printer.

10. When the message “Command Issued” appears confirming that the download is complete, click **OK** to clear the message.

**TEST PRINTING THE MACRO**

1. Choose **Printers > Test Macro**.

2. In the Test Macro window, enter its ID number and click **OK**. After a short pause the printer will print the macro.

3. When each macro has been tested, click **Exit**.

4. Click the standard Windows **Close (X)** button, or choose **Projects > Exit** to close Storage Device Manager.

**DEFINING OVERLAYS**

This is the final step before the new overlays are ready for use.

1. Open the Printers (called “Printers and Faxes” in Windows XP) window via the **Start** menu or the Windows Control Panel.

2. Right-click on the Relevant PostScript printer icon and choose **Printing Preferences** from the pop-up menu.

3. On the Job Options tab, click the **Overlay** button.

4. In the Overlay window, Click the **Define Overlays** button (1).

5. In the Define Overlays window, enter the **name** (a) and **ID** (b) of the required overlay, and define which **page(s)** (c) of your documents will use this overlay. Then click the **Add button** (3) to add this overlay to the list of defined overlays. Repeat for any other related overlays. When done, click the **Close button** (4) to close the window.

The example illustrated shows two overlays defined, one for a cover page and one for continuation pages.

Remember that names and IDs of overlay files must be entered exactly as they appeared in the Storage Device Manager project window. Remember also that names are case sensitive.

If you forgot to note the overlay name or ID when you created them, you can find them using Storage Device Manager to view the project file, or the printer’s Information Menu to print a file list and identify them from there.
The new overlays will now appear in the Defined Overlays list in the printer properties window.

6. When done, click **OK** to close the printing preferences window.

Your new overlays are now ready and available to be used for any future documents you wish.

**PRINTING WITH PCL OVERLAYS**

Once you have defined your overlays you are ready to use them for any documents you wish. The example illustrated here uses two overlays for business letters. The first prints on just the top page, and the second prints on any or all subsequent pages.

1. Prepare your document in the normal way using your own application software. Remember, if necessary, to format the document so that it will fit nicely within the plain areas on your letterhead overlay.

2. Open your application’s **Print...** dialogue and choose any options you will require, ensuring that the target printer is your PCL printer driver in which the overlays have been defined.

3. Click the **Properties** button to open the Printing Preferences window.

4. On the Overlay tab, check the **Use active overlays** checkbox (1).

5. In the Defined Overlays list, click on the first overlay (2) you wish to use, and click the **Add** button (3) to add it to the Active Overlays list. (If you want a reminder of how this overlay looks, click the **Test Print** button.)

6. If you want to use another overlay with this document, in this example it is the “Continuation Page” overlay, click this overlay (4) in the list of defined overlays, and then click the **Add** button (3) again to add the second overlay to the list of active overlays.

7. When the list of active overlays contains all the items you want to use, click **OK**.

8. Finally, click the **Print** button in your application’s Print dialogue to begin printing your document.
CONSUMABLES AND MAINTENANCE

This section deals with the replacement of the toner cartridge and image drum and general maintenance.

CONSUMABLE ORDER DETAILS

<table>
<thead>
<tr>
<th>ITEM</th>
<th>ORDER NO.</th>
<th>COMPATIBILITY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard Toner, 4,000 A4 pages (*)</td>
<td>44574703</td>
<td>B411d, B411dn, B431d, B431dn</td>
</tr>
<tr>
<td>High Capacity Toner, 10,000 A4 pages (*)</td>
<td>44574903</td>
<td>B431d, B431dn</td>
</tr>
<tr>
<td>Image Drum</td>
<td>44574303</td>
<td>B411d, B411dn, B431d, B431dn</td>
</tr>
</tbody>
</table>

(*)All toners : A4 pages yield compliant with ISO/IEC 19752. Printer shipped with 1,500 pages yield compliant with ISO/IEC 19752.

Please always use genuine consumables.

WHEN TO REPLACE THE TONER CARTRIDGE

When the toner is running low, TONER LOW is displayed in the operator panel LCD. After Toner Low displays, the printer will print about 100 more pages then display Toner Empty and stop printing. Printing will resume after a new toner cartridge has been installed.

REPLACING THE TONER CARTRIDGE

WARNING!

> Never expose a toner cartridge to an open flame. It can cause an explosion and you can be burned.
> Be sure to switch off and unplug the machine before accessing the interior of a machine for cleaning, maintenance or fault clearance. Access to a live machine’s interior can cause electric shock.

It is recommended that you clean the LED array at the same time as you change the toner cartridge.

The toner used in this printer is a very fine dry powder contained in the toner cartridge.

Have a sheet of paper handy so that you have somewhere to place the used cartridge while you install the new one.

Dispose of the old cartridge responsibly, inside the pack that the new one came in. Follow any regulations, recommendations, etc., which may be in force concerning waste recycling.

If you do spill any toner powder, lightly brush it off. If this is not enough, use a cool, damp cloth to remove any residue. Do not use hot water, and never use solvents of any kind. They will make stains permanent.

WARNING!

If you inhale any toner or get it in your eyes, drink a little water or bathe your eyes liberally in cold water. Seek medical attention immediately.
1. Switch off the printer and allow the fuser to cool for about 10 minutes before opening the top cover.

**WARNING!**

If the printer has been powered on, the fuser may be hot. This area is clearly labelled. Do not touch.

2. Press the top cover release button and open the printer’s top cover fully.

   **NOTE**
   
The B431dn model has been illustrated below. The principles are the same for all models of this printer.

3. Pull the coloured lever (1) on the right side of the toner cartridge towards the front of the printer (unlock position) to close the cartridge then remove the used toner cartridge (2).

4. Clean the top of the ID unit with a clean, lint free cloth.
5. Put the cartridge down gently onto a piece of paper to prevent toner from marking your furniture.
6. Remove the new cartridge from its box but leave its wrapping material in place for the moment.
7. Gently shake the cartridge (3) from end to end several times to loosen and distribute the toner evenly inside the cartridge.

8. Remove the wrapping material and peel off the adhesive tape from the underside of the cartridge (4).
9. Holding the cartridge by its top centre with the coloured lever to the right, lower it into the printer over the image drum unit from which the old cartridge was removed.
10. Insert the left end of the cartridge into the top of the image drum unit first (5), push it against the pins on the drum unit, then lower the right end of the cartridge down onto the image drum unit.

11. Pressing gently down on the cartridge to ensure that it is firmly seated, push the coloured lever towards the rear of the printer (lock position) (6). This will lock the cartridge into place and release toner into the image drum unit.

12. Gently wipe the LED array surface (7) with a soft tissue.
13. Close the top cover and press it down to latch it closed.

**WHEN TO REPLACE THE IMAGE DRUM**

When the drum reaches 90% of its life, a REPLACE IMAGE DRUM message is displayed in the operator panel LCD. Change the image drum when the print becomes faint or begins to deteriorate.

**REPLACING THE IMAGE DRUM.**

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; Never expose a image drum to an open flame. It can cause an explosion and you can be burned.</td>
</tr>
<tr>
<td>&gt; Be sure to switch off and unplug the machine before accessing the interior of a machine for cleaning, maintenance or fault clearance. Access to a live machine’s interior can cause electric shock.</td>
</tr>
</tbody>
</table>

---

**NOTE**

> It is recommended that you change the toner cartridge and clean the LED array at the same time as you change the image drum.

> The B431dn model has been illustrated below. The principles are the same for all the models of this printer.

---

1. Press the cover release and open the printer’s top cover fully.

<table>
<thead>
<tr>
<th>WARNING!</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the printer has been powered on, the fuser may be hot. This area is clearly labelled. Do not touch.</td>
</tr>
</tbody>
</table>

2. Holding it by its top centre, remove the used image drum and toner cartridge, out of the printer.
3. Put the assembly down gently onto a piece of paper to prevent toner from marking your furniture and to avoid damaging the green drum surface.

CAUTION!

The green image drum surface at the base of the ID unit is very delicate and light sensitive. Do not touch it and do not expose it to normal room light for more than 5 minutes. If the drum unit needs to be out of the printer for longer than this, please wrap the cartridge inside a black plastic bag to keep it away from light. Never expose the drum to direct sunlight or very bright room lighting.

4. With the coloured toner release lever to the right, pull the lever towards you. This will release the bond between the toner cartridge and the image drum unit.

5. Lift the right-hand end of the toner cartridge and then draw the cartridge to the right to release the left-hand end, and withdraw the toner cartridge out of the image drum cartridge. Place the cartridge on a piece of paper to avoid marking your furniture.

6. Take the new image drum cartridge out of its packaging and place it on the piece of paper where the old cartridge was placed. Keep it the same way round as the old unit. Pack the old cartridge inside the packaging material for disposal.

NOTE
Follow instructions that come with the new image drum for additional information such as the removal of packaging material etc.

7. Place the toner cartridge onto the new image drum cartridge. Push the left end in first, and then lower the right end in.

8. Push the coloured release lever away from you to lock the toner cartridge onto the new image drum unit and release toner into it.

9. Holding the complete assembly by its top centre, lower it into place in the printer locating the pegs (1 & 2) at each end into their slots in the sides of the printer cavity (3).

10. Gently wipe the LED array surface with a soft tissue.
11. Close the top cover and press it down to latch it closed.

**Cleaning the LED Array**

Clean the LED array whenever a new toner cartridge is installed or if there are faded vertical areas or light printing down a page.

Wipe the LED array gently with a soft tissue.
TROUBLESHOOTING

STATUS AND ERROR MESSAGES

Your printer has been designed to give you helpful status feedback not only during normal operation but also if a printing problem occurs so that you can take appropriate corrective action.

The LCD on the printer operator panel provides the self-explanatory status and error messages in your chosen language. Error messages are accompanied by the Ready indicator being extinguished.

PAPER JAMS

Provided that you follow the recommendations in this guide on use of print media, and you keep the media in good condition prior to use, your printer should give years of reliable service. However, paper jams occasionally do occur, and this section explains how to clear them quickly and simply.

Jams can occur due to paper misfeeding from a paper tray or at any point on the paper path through the printer. When a jam occurs, the printer immediately stops, and the operator panel informs you of the event. If printing multiple pages (or copies), do not assume that having cleared an obvious sheet that others will not also be stopped somewhere along the path. These must also be removed in order to clear the jam fully and restore normal operation.

The printer may experience a paper jam in one of three areas.

1. INPUT JAM - paper has failed to leave the selected feed tray and enter the internal paper path of the printer. A typical message indicates a paper jam and identifies the tray to check.
2. FEED JAM - paper has entered the printer but failed to reach the exit. A typical message indicates a paper jam and advises you to open the top cover for access.
3. EXIT JAM - paper has reached the exit but has failed to exit completely from the printer. A typical message indicates an exit jam and advises you to open the top cover for access.
**INPUT JAM**

> **NOTE**
> The B431dn model has been illustrated below. The principles are the same for all models of this printer.

1. Remove the paper tray from the printer (1).
2. Remove any crumpled or folded paper.
3. Remove any paper from the underside of the printer (2).
4. Replace the paper tray.

After successful removal of any damaged or misfed paper, the printer should continue printing.

**FEED JAM OR EXIT JAM**

1. Remove the tray and clear any misfed sheets as given above.
2. Press the cover release and open the printer’s top cover.

---

**WARNING!**

If the printer has been powered on, the fuser area will be hot. This area is clearly marked. Do not touch it.

---

**CAUTION!**

Never expose the image drum unit to light for more than 5 minutes. Never expose the image drum unit to direct sunlight. Always hold the image drum unit by the ends or from the top. Never touch the surface of the green drum inside the image drum unit.
3. Carefully lift out the image drum, complete with the toner cartridge. Be careful not to touch or scratch the green drum surface.

4. Remove any jammed sheets from the paper path.

5. Re-install the image drum complete with toner cartridge, ensuring that the pegs (1 & 2) correctly locate into the slots on each side of the printer (3).

6. Lower the top cover but do not press down to latch it closed yet. This will protect the drum from excessive exposure to room lighting, while you check the remaining area for jammed sheets.
7. Remove any jammed paper from the face down stacker.

8. Remove any jammed paper from the face up stacker.

9. Open the rear cover and check for paper in the rear path.
   > Pull out any paper found in this area.

   > Close it once the paper is removed from this area.

**NOTE**

If the edge of the jammed paper protrudes (or can be seen) from the exit, reinstall the image drum, close the top cover and switch the printer on. Remove the jammed paper from the exit when the exit roller begins rotating after a few seconds after switching on. However, if the jammed paper cannot be removed, contact a service representative.
10. Check for paper jam in duplex unit.
   > Remove the Image Drum as described in step 3., then, remove the Duplex unit (1) by raising the coloured handles (2) on each side, and then by holding the handles and gently lifting it out.
   > Remove any paper and replace the duplex unit.
   > Re-install the image drum as described in step 5.

11. Check for paper jam under the Paper Guard.
   > Remove the Image Drum as described in step 3.
Raise the Paper Guard (1) and remove the paper. Lower the Paper Guard back into position.

> Re-install the image drum as described in step 5.

12. Open the Multi Purpose Tray (1) (Manual Feed Tray for B411d and B411dn).
   > Remove any paper that you find (2), and then close the tray.

13. Close the top cover and press down to latch it closed.
14. The printer will warm up and commence printing when ready. The page lost through the jam will normally be reprinted.
**Print quality problems**

Before consulting a service representative regarding a print quality problem, check the table below to see if there is a solution, or something you might have overlooked.

<table>
<thead>
<tr>
<th>Symptom</th>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blank sheets printed.</td>
<td>Image drum cartridge not properly installed.</td>
<td>Reinstall image drum cartridge.</td>
</tr>
<tr>
<td></td>
<td>Empty or missing toner cartridge.</td>
<td>Install new toner cartridge.</td>
</tr>
<tr>
<td>Entire page prints faintly.</td>
<td>Empty toner cartridge. Pages get fainter when toner is used up.</td>
<td>Install new toner cartridge.</td>
</tr>
<tr>
<td></td>
<td>LED array is dirty.</td>
<td>Clean LED array.</td>
</tr>
<tr>
<td>Page has grey background.</td>
<td>Static electricity, generally from dry environments, causes toner to stick to background.</td>
<td>Change paper to a smoother laser bond or use a humidifier.</td>
</tr>
<tr>
<td>Page prints all black.</td>
<td>Hardware problem.</td>
<td>Contact service.</td>
</tr>
<tr>
<td>Oblong area of faint print appears on each page.</td>
<td>Drop out caused by using paper exposed to high humidity.</td>
<td>Change paper stocks, check paper storage environment or use a dehumidifier; check toner level.</td>
</tr>
<tr>
<td>Vertical white streaking or faint areas on page.</td>
<td>Toner is low and does not distribute properly, or the drum is worn out.</td>
<td>Replace toner cartridge. Check drum and replace the drum, if necessary. Contact service.</td>
</tr>
<tr>
<td></td>
<td>LED array is dirty.</td>
<td>Clean LED array.</td>
</tr>
<tr>
<td>Vertical black lines.</td>
<td>Hardware problem.</td>
<td>Contact service.</td>
</tr>
<tr>
<td>Fuzzy print.</td>
<td>LED array is dirty.</td>
<td>Clean LED array.</td>
</tr>
<tr>
<td>Faded print.</td>
<td>Toner cartridge is not correctly installed.</td>
<td>Install toner cartridge correctly.</td>
</tr>
<tr>
<td></td>
<td>Toner low.</td>
<td>Replace toner cartridge.</td>
</tr>
<tr>
<td>Smeared or blotched print.</td>
<td>Dirty rollers; toner dropped inside printer or image drum problem.</td>
<td>Replace image drum and toner. Contact service.</td>
</tr>
<tr>
<td>Printed page is light/blurred.</td>
<td>Is toner low?</td>
<td>Replace toner cartridge.</td>
</tr>
<tr>
<td></td>
<td>Is paper meant for laser printers?</td>
<td>Use recommended paper.</td>
</tr>
<tr>
<td></td>
<td>LED array is dirty.</td>
<td>Clean LED array.</td>
</tr>
<tr>
<td>Bold characters and dark lines are smeared.</td>
<td>Toner is low.</td>
<td>Install new toner cartridge.</td>
</tr>
<tr>
<td>Print is darker than usual.</td>
<td>Darkness setting is too high.</td>
<td>Change darkness setting.</td>
</tr>
</tbody>
</table>
## PAPER FEED PROBLEMS

<table>
<thead>
<tr>
<th>SYMPTOM</th>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pages curl excessively.</td>
<td>Printing on wrong side of paper.</td>
<td>Turn paper over in tray. (Note arrow on paper package). Install paper print side down in tray.</td>
</tr>
<tr>
<td></td>
<td>High humidity.</td>
<td>Recommended operating humidity: 20-80%.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SYMPTOM</th>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper Jams occur frequently. Multiple sheets of paper are fed at the same time.</td>
<td>The printer is tilted.</td>
<td>Place the paper on a stable and flat surface.</td>
</tr>
<tr>
<td></td>
<td>Paper is too thick or too thin. Paper is moist, folded, creased or warped.</td>
<td>Use paper suitable for the printer. Avoid storing paper in areas of excessive temperature and humidity. Store paper in protective wrapping</td>
</tr>
<tr>
<td></td>
<td>Paper is not aligned.</td>
<td>Align the paper edges to the paper guides.</td>
</tr>
<tr>
<td></td>
<td>Only one sheet of paper is loaded in the Paper tray or Manual Feed/Multi Purpose tray.</td>
<td>Load several sheets of paper.</td>
</tr>
<tr>
<td></td>
<td>Sheets of paper is added to the existing paper stock in the Paper tray or Manual Feed/ Multi Purpose tray.</td>
<td>Remove existing sheets of paper from the tray and add the new sheets to them, ensuring alignment and then load the tray.</td>
</tr>
<tr>
<td></td>
<td>Postcards, envelopes, label sheets or transparencies are loaded in the Paper tray.</td>
<td>You cannot print using the Paper tray. Load postcards, envelopes, label sheets or transparencies in the Manual Feed tray or Multi Purpose tray.</td>
</tr>
<tr>
<td></td>
<td>Postcards or envelopes are placed in the wrong orientation.</td>
<td>Check and load in the correct orientation.</td>
</tr>
<tr>
<td>Paper is not fed into the printer.</td>
<td>Improper setting is selected for Paper Source in the printer driver.</td>
<td>Select the correct paper source from the Source drop down menu.</td>
</tr>
<tr>
<td></td>
<td>The printer menu setting is incorrect.</td>
<td>Set the size of the paper in the Setup Menu of the printer.</td>
</tr>
<tr>
<td>Printing does not resume after removing jammed paper.</td>
<td>Printing does not resume only by removing paper jam.</td>
<td>Open and close the top cover.</td>
</tr>
</tbody>
</table>
**SOFTWARE PROBLEMS**

Your software (operating environment, applications and printer drivers) controls the printing process. Make sure you have selected the right driver for use with your printer. See your software documentation for more information.

<table>
<thead>
<tr>
<th>SYMPTOM</th>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing is garbled.</td>
<td>Incorrect driver is installed.</td>
<td>Install an appropriate driver.</td>
</tr>
<tr>
<td>Printer’s output is below rated speed.</td>
<td>Much of the printing delays will be caused by your application. Sometimes purely text documents will print slowly depending on the selected fonts and how they are transferred to the printer.</td>
<td>For maximum speed, use text in your document and use a printer resident font.</td>
</tr>
<tr>
<td>Size of top margin increases with each page printed.</td>
<td>Creeping text. Number of lines per page in software is not equal to number of lines per page of printer.</td>
<td>Many software packages assume 66 lines per page, but your printer’s default is 64. Adjust software accordingly, or set LINES Per PAGE in the soft control panel to equal lines per page in your software.</td>
</tr>
</tbody>
</table>

**HARDWARE PROBLEMS**

<table>
<thead>
<tr>
<th>SYMPTOM</th>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graphic image prints partly on one page, partly on the next.</td>
<td>Insufficient printer memory for this image at this resolution.</td>
<td>Change the resolution, reduce the image size, or install more memory in your printer.</td>
</tr>
<tr>
<td>When you try to print nothing happens, but printer indicates it is ready to receive data.</td>
<td>Configuration error.</td>
<td>Check cable connection. If more than one printer is available, make sure your printer has been selected.</td>
</tr>
<tr>
<td>Garbage prints.</td>
<td>Incorrect cable configuration. Also, see Software Problems.</td>
<td>Check cable configuration, continuity, and length.</td>
</tr>
<tr>
<td>Printer freezes or displays error message when computer is rebooted.</td>
<td>Booting the computer while the printer is on can cause a communications error.</td>
<td>Turn printer off before rebooting computer.</td>
</tr>
<tr>
<td>Odours.</td>
<td>Gases are given off by forms or adhesives passing through the hot fusing unit.</td>
<td>Make sure the forms you use can withstand heating, and provide adequate ventilation.</td>
</tr>
<tr>
<td>Printer is on but must warm up before a job is printed.</td>
<td>Power Save mode is set on to conserve energy. The fuser must heat up before you can begin printing the next job.</td>
<td>To eliminate warm up delay, change Power Save setting.</td>
</tr>
</tbody>
</table>
INSTALLING OPTIONS

The following options are available to extend the performance of your printer:

> 64, 128, 256MB RAM DIMM: to extend the main memory of your printer and speed up the processing of large files

> Second paper tray: to increase your printer’s paper handling capacity by 530 sheets (80g/m²)

OPTIONS ORDER DETAILS

<table>
<thead>
<tr>
<th>ITEM</th>
<th>ORDER NO.</th>
</tr>
</thead>
<tbody>
<tr>
<td>64MB Memory</td>
<td>44615403</td>
</tr>
<tr>
<td>128MB Memory</td>
<td>44615407</td>
</tr>
<tr>
<td>256MB Memory</td>
<td>44615412</td>
</tr>
<tr>
<td>2nd Tray</td>
<td>44575702</td>
</tr>
</tbody>
</table>

Please always use genuine options.

INSTALLATION PROCEDURE

To install any of the above options, follow the detailed installation sheet that accompanies the option.
SPECIFICATIONS

GENERAL

<table>
<thead>
<tr>
<th>PRINTER MODEL</th>
<th>MODEL NUMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td>B411d</td>
<td>N22200B</td>
</tr>
<tr>
<td>B411dn</td>
<td>N22201B</td>
</tr>
<tr>
<td>B431d</td>
<td>N22202B</td>
</tr>
<tr>
<td>B431dn</td>
<td>N22203B</td>
</tr>
</tbody>
</table>

A summary of the basic characteristics of your printer appears in the table below:

<table>
<thead>
<tr>
<th>ITEM</th>
<th>SPECIFICATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions</td>
<td>387mm x 364mm x 244.5mm (W x D x H)</td>
</tr>
<tr>
<td>Weight</td>
<td>11.6kg approximately (without second tray)</td>
</tr>
<tr>
<td>Power supply</td>
<td>220 to 240VAC @ 50 - 60Hz ± 2%</td>
</tr>
</tbody>
</table>
| Power consumption (with options installed) | Typical:  
B411: 510W; B431: 550W  
Idle: 70W  
Power save mode: 8W  
Noise level | Operation: B411: 53 dB(A); B431: 54dB(A)  
Standby mode: 30dB(A)  
Power saving mode: Background level  
Environmental conditions | Operation: 10 - 32°C, 20% - 80% RH,  
Storage: -10-43°C, 10% - 90% RH  
When the printer is stored, it should be in its original packaging, with no moisture formation. |
## Paper and Tray Information

Feed and ejection methods vary depending on the type, size and thickness of medium used. Use the chart below and the notes/symbols/terms on the following page for initial guidance. (Minor variations to settings may be necessary depending on user setup and environmental conditions).

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Weight</th>
<th>T1</th>
<th>T2</th>
<th>MPT</th>
<th>MF</th>
<th>FU</th>
<th>FD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>A4</td>
<td>L,ML,M,MH,H</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Executive</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16K (184 - 260mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16K (195 - 270mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16K (197 - 273mm)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal(13)</td>
<td>L,ML,M,MH,H</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Legal(13.5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal(14)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6</td>
<td>L,ML,M,MH,H</td>
<td>0</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Statement</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td>L,ML,M,MH,H</td>
<td>△</td>
<td>△</td>
<td>0</td>
<td>0</td>
<td>△</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>W: 86 - 216mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>L: 140 - 1321mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A4</td>
<td>UH</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>B5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Letter</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Executive</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal(13)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal(13.5)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Legal(14)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>A6</td>
<td>UH</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Statement</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td>UH</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>W: 86 - 216mm</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>L: 140 - 356</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Postcards</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td>Envelopes</td>
<td>Com-9</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Com-10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>DL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>C6</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Monarch</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Custom</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>W: 86 - 216</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>L: 140 - 356</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Specifications > 76
<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Weight</th>
<th>T1</th>
<th>T2</th>
<th>MPT</th>
<th>MF</th>
<th>FU</th>
<th>FD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels</td>
<td>A4 Letter</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>A4 Letter</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feed Tray</th>
<th>Ejection Method</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paper type</td>
<td>Size</td>
</tr>
<tr>
<td>Labels</td>
<td>A4 Letter</td>
</tr>
<tr>
<td>Transparencies</td>
<td>A4 Letter</td>
</tr>
</tbody>
</table>

### Duplex Printing

<table>
<thead>
<tr>
<th>Paper type</th>
<th>Size</th>
<th>Weight</th>
<th>T1</th>
<th>T2</th>
<th>MPT</th>
<th>MF</th>
<th>T1</th>
<th>T2</th>
<th>MPT</th>
<th>MF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain paper</td>
<td>A4 B5 Letter Executive Legal(13) Legal(13.5) Legal(14)</td>
<td>L,ML,M, MH, H</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>A6 A5 Statement</td>
<td>L,ML,M, MH, H</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>0</td>
<td>X</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>Custom W: 86 - 216mm L: 140 - 1321mm</td>
<td>L,ML,M, MH, H</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>Δ</td>
<td>Δ</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>A4 B5 Letter Executive Legal(13) Legal(13.5) Legal(14)</td>
<td>UH</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>A6 A5 Statement</td>
<td>UH</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Custom W: 86 - 216mm L: 140 - 1321mm</td>
<td>UH</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td></td>
<td>Postcards</td>
<td>-</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
NOTES/SYMBOLS/TERMS

Notes:
1. When an optional second paper tray is used, the original tray is referred to as Tray 1 and the optional tray as Tray 2.
2. It is possible to use custom paper sizes with the PS emulation driver.
3. Tray 1 can accommodate paper with width of 100 to 216mm and length of 148 to 356mm.
4. Tray 2 can accommodate paper with width of 148 to 216mm and length of 210 to 356mm.
5. When printing using Auto Duplex, paper will not be ejected face up.
6. The printing speed is reduced when you set the paper size of A5, A6, Postcards, Envelopes as Medium heavy, Heavy or Ultra heavy.
7. Change the ejection mode to face down if the paper is curled up.
8. Change the ejection mode to face up if the paper curl is large.
9. When changing media settings, allow 15 seconds for the printer to adjust to the new setting.

<table>
<thead>
<tr>
<th>SYMBOL/Term</th>
<th>MEANING</th>
</tr>
</thead>
<tbody>
<tr>
<td>T1</td>
<td>Paper Tray 1</td>
</tr>
<tr>
<td>T2</td>
<td>Paper Tray 2 (optional)</td>
</tr>
<tr>
<td>MPT</td>
<td>Multi Purpose Tray (B431)</td>
</tr>
<tr>
<td>MF</td>
<td>Manual Feed Tray (B411)</td>
</tr>
<tr>
<td>FU</td>
<td>Face Up printing from the rear of the printer</td>
</tr>
<tr>
<td>FD</td>
<td>Face Down printing from the top of the printer</td>
</tr>
<tr>
<td>W, L</td>
<td>Width, Length in mm</td>
</tr>
<tr>
<td>SYMBOL/TERM</td>
<td>MEANING</td>
</tr>
<tr>
<td>-------------</td>
<td>---------</td>
</tr>
<tr>
<td>L</td>
<td>Light paper weight: 60 - 66g/m²</td>
</tr>
<tr>
<td>ML</td>
<td>Medium Light paper weight: 67 - 73g/m²</td>
</tr>
<tr>
<td>M</td>
<td>Medium paper weight: 74 - 88g/m²</td>
</tr>
<tr>
<td>MH</td>
<td>Medium Heavy paper weight: 89 - 104g/m²</td>
</tr>
<tr>
<td>H</td>
<td>Heavy paper weight: 105 - 122g/m²</td>
</tr>
<tr>
<td>UH</td>
<td>Ultra Heavy paper weight: 123g/m² - 160g/m²</td>
</tr>
<tr>
<td>o</td>
<td>Can be used</td>
</tr>
<tr>
<td>x</td>
<td>Cannot be used</td>
</tr>
<tr>
<td>△</td>
<td>Can be used depending on the size.</td>
</tr>
</tbody>
</table>
INDEX

Numerics
2-sided printing................. 49

A
Adhesive labels................ 30
Advanced features
   enabling or disabling...... 47
Attention LED.................. 12
Auto duplex printing.......... 49

E
Envelopes
   Types.......................... 30
Exit paper jam................ 66

F
Feed jam or exit jam.......... 66
Feed paper jam............... 66

I
Image drum
   Replacing..................... 62
Input paper jam.............. 66
installed options
   Macintosh..................... 38
Windows........................ 38
Installing
   Paper............................ 31
installing Configuration
   Tool.............................. 38
installing drivers
   Macintosh..................... 38
Windows........................ 38
Installing paper............... 31
interface
   parallel......................... 37
   USB................................ 37

L
Labels.......................... 30, 31
LAN................................. 37
LCD................................. 22
LED array.......................... 64
LED indicators.................. 12

M
Macros............................ 53
Maintenance
   Cleaning LED array......... 64
Manual Duplex
   Multi Purpose Tray......... 51
   Paper Tray..................... 49
Manual Duplex printing....... 49
media settings
   B411d, B411dn.............. 34
   B431d, B431dn.............. 35
menu functions
   B411d, B411dn.............. 15
   B431d, B431dn.............. 24
menu settings
   B411d, B411dn.............. 21
   B431d, B431dn.............. 29
Menus
   FX menu.................... 18, 27
   Information menu.......... 15, 24
   Maintenance menu.......... 20, 29
   Media menu.................. 16, 25
   Network menu............... 19, 28
   Parallel menu............... 19, 27
   PCL menu................... 17, 26
   PPR menu................... 18, 26
   Print menu.................. 16, 24
   Shutdown menu............. 24
   System configuration
      menu....................... 17, 25
   Usage menu.................. 20, 29
   USB menu................... 19, 28
   Multi purpose tray and manual
      feed tray.................. 33

O
online button
   B411d, B411dn............ 13
operator panel
   B411d, B411dn............ 12
   B431d, B431dn............ 22
options
   installing.................... 74
   Overlays........................ 53
   Overlays and macros
general...................... 41, 53
   Overlays, PCL
   how to create................ 56
   printing with
      overlays................... 57, 58
   Overlays, PostScript
defining in the Windows
   driver.......................... 54
   how to create................ 53
   printing with overlays..... 55

P
Page orientation
   setting in Windows........ 41, 43
Paper
   Envelope types............. 30
   Exit jam...................... 66
   Feed jam...................... 66
   feed sequence................ 32
   Input jam...................... 66
   Installing.................... 31
   Label types.................. 30, 31
   Paper types.................. 30
   size setting in Windows.... 40
   Transparencies............. 30, 31
   tray selection in
      Windows.................... 40
   Paper and envelope
types.......................... 30
   paper and trays........... 76
   paper feed problems....... 72
   Paper feed, size and media
      setting........................ 34
   Paper jams................... 65
   Print order
      face down printing........ 32
      face up printing........... 32
   Print quality problems..... 71
   Print settings
      how to save................ 40
   printer components........ 10
   Printer default settings
      Windows defaults........ 45
   printer features........... 7

Printing
   different media............ 52
   Label types............... 30, 31
   Paper & envelope types.... 30
   Quality problems.......... 71
   Transparency types........ 30, 31
   Priority
      print queue priority..... 46

R
Ready LED.................... 12
Resolution
   setting in Windows........ 41, 44

S
Separator page
   separating print jobs on a
      shared printer........... 47
Software problems........... 73
   specifications
      general..................... 75
      paper and trays.......... 76
   Spooling
      Windows settings......... 46
   status & error messages... 65
   support materials.......... 8

T
Toner
   how to replace............. 59
Troubleshooting
   Hardware problems......... 73
   Paper jams.................. 65
   Print quality problems.... 71
   Software problems........ 73

U
user's guide
   printing....................... 8
   viewing....................... 8

W
Watermark
   printing in Windows......... 41, 45

Index > 80
OKI CONTACT DETAILS

Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore (119967)
Tel: (65) 6221 3722
Fax: (65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
1168/79, 81-82 Lumpini Tower,
27th Floor, Rama IV Rd.,
Tungmahamek, Sathorn
Bangkok 10120,
Thailand
Tel: (+66) 2679 9235
Fax: (+66) 2679 9243
http://www.okisysthai.com

Oki Systems (Hong Kong) Ltd.
Unit 607, 6/F, Island Place Tower,
510 Kings Road, North Point,
Hong Kong
Tel: (852) 3543 9200
Fax: (852) 3549 6040
http://www.okiprintingsolutions.com.hk

Oki Data (Australia) Pty Ltd.
146 O’Riordan Street Mascot,
NSW 2020, Australia
Tel: +61 (02) 9667 7240
Fax: +61 (02) 9667 7333
http://www.oki.com.au

Comworth Systems Ltd.
8 Antares Drive Mairangi Bay,
Auckland, New Zealand
Tel: (64) 9 477 0500
Fax: (64) 9 477 0549
http://www.comworth.co.nz

Oki Data(S) P Ltd. Malaysia Rep Office
Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia
Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166